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1 About the MEA Application Examples 

MC_Rack is a very flexible recording and analysis program that can be customized for various 
applications. Different software configurations can be saved for later use in so-called virtual rack 
files, in analogy to a hardware rack configuration.  

In this chapter, you will find a detailed description of demo rack configurations for various 
typical applications. You will find the demo racks together with demo data files in the Tutorial 
folder (Offline subfolder) on the installation volume. These racks are only suitable for replaying 
demo data files, not for new experiments, but if you follow the step-by-step instructions in the 
tutorial you will get an idea how to set up a rack for your particular application. 

The different applications described in this tutorial are intended to be read separately, that is, 
important facts about MC_Rack are repeated in each section. On the other hand, not all MC_Rack 
features are explained in detail in each application section. In the chapters "Aim of Experiment", 
a short introduction into the application is given as well as a list of features that will be discussed 
in the section. For example, if you are interested in extracting spikes from brain slices, it might be 
interesting for you to study the "Retina: MicroERGs and Spikes" chapter to learn more about the 
spike detection methods in MC_Rack, even if you are not interested in the retina application itself. 
See list below. 

Example racks that can be directly used for experiments are provided in the Online subfolder. 
You can load and modify these racks for your application instead of setting up a virtual rack  
from scratch. Some of the racks are very basic and provide a good introduction into basic MC_Rack 
features. Two of the basic racks are discussed in the Step by Step Tutorial. Others are more 
advanced and demonstrate the possibilities that MC_Rack offers. (If you have no data acquisition 
system (MC_Card or USB-MEA- or USB-ME-System) available, you can use the Simulation mode  
of the data source for working with the online sample racks, or load the offline sample racks into 
the Replayer). 

You will find a list and a short description of all sample racks in the MC_Rack Sample Racks topic. 
This document may not always be up to date. For the latest documentation, please see the 
MC_Rack_SampleRacks_ReadMe.htm file in the Tutorial folder on the installation volume. 

The following list provides an overview which application section focuses on which MC_Rack 
features. 

Application section Discussed features 

Getting Started Starting MC_Rack, recording data, replaying data 
files in general. 

Long Term Potentiation (LTP) Field potential (waveform) analysis, amplitude 
extraction, graphics and ASCII export. 

Input/Output (I/O) Curve Field potential (waveform) analysis, slope 
extraction. 

Paired Pulse Facilitation (PPF) or 
Depression (PPD) 

Field potential (waveform) analysis, amplitude 
extraction, triggering MC_Rack. 

Spike Activity (Organotypic culture) Digital filtering, spike detection (threshold 
mode), spike rate extraction, two-dimensional 
false-color plots. 

Retina: MicroERGs and Spikes Digital filtering, spike detection (threshold and 
slope mode). 

Cardiac Signals Excitation map, extraction of QT interval, 
averaging data. 

Saving the Rack and Saving Data Saving rack configuration files, recording data. 
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2 MC_Rack Sample Racks 

The offline racks and the demo data are provided in the Tutorial folder on the installation 
volume. The demo data need to be copied to the correct file path. Please copy the complete 
MC_Rack Tutorial folder into the MC_Rack directory with the following path.  

c:\Program Files\Multi Channel Systems\MC_Rack\  

Otherwise the file paths of the data files are not valid and the program cannot find the files, 
resulting in an error message. This is no problem, however, but you will have to select the data 
files manually.  

The intention of the offline racks is to show possible applications, and how to set up a rack.  
It is not possible to use offline racks for recording.  

The online racks can be used as templates for your experiments instead of setting up new racks 
from scratch. You only have to adjust the parameters according to your needs.  
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3 Sample Racks - Overview 

Neurophysiology Retina Cardiophysiology 

MEA / in vitro - Offline/Demo Racks 

Hippocampus_IOCurve_Demo.rck   

Neuro_LTP_Demo.rck   

Neuro_PPF_Demo.rck   

Neuro_OTC_Spikes_Demo.rck   

Neuro_Cerebellum_Demo.rck   

Neurons_DrugApplications_Demo.rck   

 Retina_MicroERG_Demo.rck  

 Retina_Spikes_Demo.rck  

    

  Cardiomyocytes_ExcitationMap_Demo.rck 

  Cardiomyocytes_QT-Analysis_Demo.rck 

  hESC-CM_NoStim_Demo.rck  

  hESC-CM_Stim_Demo.rck  

  Cardiomyocytes_HL1_Demo.rck 

  Murine-ESC-CM_EB_Iso.rck 

  hESC-CM_EB_Iso.rck 

  Cardio_WholeHeart_Chicken.rck 

ME / in vivo - Offline/Demo Racks 

InVivo_Rat_Chronic.rck   

InVivo_RatBarrelCortex_FlexMEA.rck   
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Online/Template Racks 

Display_Continuous.rck Display_Continuous.rck Display_Continuous.rck 

Display_Triggered.rck Display_Triggered.rck Display_Triggered.rck 

MEA1060-BC.rck   

MEA-120-System.rck MEA-120-System.rck MEA-120-System.rck 

SpikeDetection.rck SpikeDetection.rck  

SpikeDetectionModes.rck SpikeDetectionModes.rck  

Neuro_Spikes_LED_Display.rck   

Neuro_LFP_SlopeAnalysis.rck   

Neuro_Spikes+FieldPotentials.rck Neuro_Spikes+FieldPotentials.rck  

Bandpassfilter.rck Bandpassfilter.rck Bandpassfilter.rck 

Neuro_LTP_analysis.rck   

Neuro_PPF.rck   

SpikeRate_5minBins.rck   

  Cardio_Averaging+ExcitationMap.rck 

  Cardio_SignalRate+RRInterval.rck 
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4 MEA / in vitro - Offline/Demo Racks 

The provided sample racks show two typical MEA applications and demonstrate the power  
and features of the data acquisition and analysis program MC_Rack. These racks are replaying 
recorded data files, that is, you can use these racks without a connected MEA-System.  

For more information about the racks and how to set them up, please refer to the Step by Step 
Tutorial in the MC_Rack Help.  

4.1 Neurobiology 

4.1.1 Acute Hippocampus Slice: fEPSP Analysis, Recording of an I/O Curve 

Consider you have recorded from an acute hippocampal slice on a Microelectrode Array (MEA) 
with 64 channels and you like to analyze the input-output relationship of an electrical stimulation.  

The biological sample was 300 μm thick (see picture) and stemmed from a 22 days old rat.  
The tissue has been stimulated with one of the substrate integrated electrodes (#65). 
 A monopolar electrical stimulation with biphasic voltage pulses (duration of 100 μs per phase) 
with amplitudes from 500 to 3000 mV, in 250 mV steps, was applied. Individual voltage steps  
were repeated 5 times with a delay of 5 s, that is, 5 x 500 mV, then 5 x 750 mV, then 5 x 1000 mV, 
and so on. The Sync Out signal of the STG (stimulus generator) was used to trigger the recording 
sweeps, with a pre-trigger of 10 ms and a time window of 70 ms.  

This example shows a recording with the new MEA amplifier with blanking circuit, featuring  
a superior stimulus artifact suppression. The Sync Out signal of the STG also triggered the MEA 
amplifier. The electrodes were transiently (for 500 μs: Sync Out pulse 300 μs long, Wait settings  
200 μs) separated from the amplifier stage during stimulation. Thus, stimulus artifacts could be 
efficiently prevented on all recording channels.  

(Data kindly provided by Dr. Frank Hofmann, University of Heidelberg, Germany) 

 Rack file: Hippocampus_IOCurve_Demo.rck  
 Data file: I-Ocurve_Demo.mcd  
 Image file: Hippocampus_IOCurve.jpg  

4.1.2 LTP-Demo rack: Theta burst induced Long Term Potentiation (LTP) 

This example file was recorded from an acute hippocampal slice on a Microelectrode Array 
(MEA) with 64 channels with the aim to analyze long-term potentiation (LTP) following  
electrical stimulation. 

The 300 μm thick acute hippocampus slice was prepared from a 21 days old rat. The slice was 
stimulated every 60 s with a single biphasic pulse (1.5 V amplitude, 100 μs per phase) by one  
of the embedded MEA-electrodes (No. 75).  

LTP was induced by an LTP train with 100 pulses of same amplitude and duration as the test 
stimulus, and a frequency of 100 Hz. The Sync Out signal of the STG (stimulus generator) has  
been used to trigger the recording, with a pre-trigger of 30 ms and a time window of 100 ms. 
Data was recorded before and after the LTP induction; the LTP induction itself was not recorded. 

As the data was acquired with a MEA1060-BC amplifier with blanking circuit, all MEA electrodes 
were disconnected from the amplifier shortly during stimulation, in this case for 540 μs  
(300 μs Sync Out pulse of the STG, plus intrinsic Wait of 40 μs, plus user defined Wait of 200 μs). 
This efficiently prevented stimulus artifacts. 
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(Data kindly provided by Dr. Frank Hofmann, University of Heidelberg, Germany) 

 Rack file: Neuro_LTP_Demo.rck  
 Data file: LTP-Demo.mcd  
 Image file: LTP_slice.jpg  

4.1.3 Paired pulse facilitation (PPF) and Depression (PPD) 

In Paired Pulse Faciliation (PPF) or Depression (PPD) experiments, the stimulus is followed by  
a second stimulus, typically 20-60 ms later. The amplitude of the sum potential of the neuronal 
response to the second stimulus is compared to that of the first one. It is higher in case of a paired 
pulse facilitation, or lower in case of a paired pulse depression. Some electrodes recorded PPF,  
and others PPD in this demo data file. For example, you can see a PPF on electrode 53, and a PPD 
on electrode 66. 

In MC_Rack, two (or more) regions of interest (ROI) can be defined, one triggered by the first 
stimulus, the other by the second stimulus, for example. The peak-to-peak amplitudes for both 
ROIs can be extracted automatically and online. 

The example data file was recorded from a 300 μm thick acute hippocampus slice that was 
prepared from a 32 days old rat. The slice was stimulated with a single biphasic pulse  
(2 V amplitude, 100 μs per phase) by one of the embedded MEA-electrodes (No. 64). The second 
stimulus pulse was applied 20 ms following the first one. Recording was triggered by applying  
the Sync Out signal of the stimulus generator to one of the analog input channels (A1). Recorded 
sweeps are 200 ms, with a pre-trigger time of 30 ms, and a post-trigger time of 170 ms. 

As the data was acquired with a MEA1060-BC amplifier with blanking circuit, all MEA electrodes 
were disconnected from the amplifier shortly during stimulation, in this case for 540 μs  
(300 μs Sync Out pulse of the STG, plus intrinsic Wait of 40 μs, plus user defined Wait of 200 μs). 
This efficiently prevented stimulus artifacts. 

(Data kindly provided by Dr. Frank Hofmann, University of Heidelberg, Germany) 

 Rack file: Neuro_PPF_Demo.rck  
 Data file: PPF_Data.mcd  
 Image file: PPF_Image.jpg  

4.1.4 OTC Spikes Demo rack: Organotypic co-culture with spontaneous spike activity 

Consider an organotypic co-culture of the dendate gyrus (DG) and the entorhinal cortex (EC) 
taken from a PND 6 rat, cultured for seven days. Both subregions show an independent 
spontaneous spike activity. Total recording time has been 60 seconds.  

(Data kindly provided by Dr. Frank Hofmann, University of Heidelberg, Germany) 

 Rack file: Neuro_OTC_Spikes_Demo.rck  
 Data file: Neuro_OTC_Spikes_Demo.mcd  
 Image file: OTC Spikes Image.jpg  

4.1.5 Acute slices from cerebellum 

You can also study acute slices from the cerebellum with the MEA-System, for example for drug 
screening. The demo data shows typical signals from the cerebellum. Four selected electrodes of 
interest are marked with a white circle in the slice picture. Any standard MEA, for example with  
a medium spatial resolution (200/30), can be used for recordings from acute slices. 

The demo rack shows the raw data from all 60 electrodes, and extracts the spike rate from four 
selected electrodes of interest.  

(Data kindly provided by Dr. Ulrich Egert, University of Freiburg, Germany) 
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 Rack file: Neuro_Cerebellum_Demo.rck  
 Data file: Cerebellum_Demo.mcd  
 Image file: Cerebellum.jpg  

4.1.6 Neuronal cell culture, drug testing 

Data was recorded from a neuronal cell culture with rat striatum cells. The example shows the 
application of NMDA. Two demo data files are provided: neurons_NMDA_control.mcd before 
drug application, neurons_NMDA_5μM after drug application. The Analyzer extracts the spike 
number in 100 ms bins: Under control conditions, over 60 % of these bins are empty, that is, 
without spike activity. This demonstrates the organization of the spontaneous spiking activity  
in bursts. After NMDA application, the spiking activity is more randomn, demonstrated by the fact 
that only 8 % of the bins are empty. The overall spiking activity measured in 2 s bins and displayed 
in spike numbers is increased, too, but the main difference is how the activity is organized.  

(Data kindly provided by W. Fleischer, University of Düsseldorf) 

 Rack file: Neurons_DrugApplication_Demo.rck  
 Data files: neurons_NMDA_control.mcd (before compound application), neurons_NMDA_5µM.mcd 

(after compound application)  

4.2 Retina 

4.2.1 Field potential electroretinogram 

The electroretinogram (ERG) is an extracellular field potential generated by the cells in the retina. 
So-called microERGs can be recorded with the MEA-System from retina explants, for example, 
from rat or chicken.  

(Data kindly provided by NMI Reutlingen, Germany)  

 Rack file: Retina_MicroERG_Demo.rck  
 Data file: Retina_ERG.mcd  

4.2.2 Spiking activity 

Spiking activity is visible in the ERG traces as well and can be easily extracted from the underlying 
field potential with the Spike Sorter in Slope mode.  

Alternatively, the field potentials can be removed by a 300 Hz High Pass filter, and spikes can  
be detected by setting a threshold. This sample rack demonstrates both methods, and the spike 
sorting feature. 

The raster plot highlights the regular spike pattern.  

(Data kindly provided by NMI Reutlingen, Germany)  

 Rack file: Retina_Spikes_Demo.rck  
 Data file: Retina.mcd  
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4.3 Cardiophysiology 

4.3.1 Excitation map (chicken embryonic cardiomyocytes) 

The two-dimensional MEA layout is ideally suited for showing the waveform propagation and 
measuring the conduction velocity in a cardiomyocyte culture. The demo data shown here was 
recorded from chicken embryonic cardiomyocytes at a sampling rate of 10 kHz with a gain of 
1200, and a bandwidth of 1 Hz to 3 kHz.  

 Rack file: Cardiomyocytes_ExcitationMap_Demo.rck  
 Data file: Cardiomyocytes_60Ch.mcd  

4.3.2 Excitation map (HL1 cell line) 

The demo data used here was recorded from a cardiomyocyte cell line from mouse that retains  
a differentiated cardiac myocyte phenotype: HL-1 from Dr. W. Claycomb. The demo data file 
Cardiomyocytes_HL1.mcd was recorded from HL-1 cells at a sampling rate of 10 kHz with a gain  
of 1000, and a bandwidth of 1 Hz to 3 kHz.  

 Rack file: Cardiomyocytes_ExcitationMap_HL1.rck  
 Data file: Cardiomyocytes_HL1.mcd  

4.3.3 QT prolongation 

The QT interval is an important parameter for drug testing. It can be extracted from the cardiac 
field potential recorded with the MEA-System. The demo data shown here was recorded from 
chicken embryonic cardiomyocytes at a sampling rate of 10 kHz with a gain of 1200, and a 
bandwidth of 1 Hz to 3 kHz. The data was filtered with a digital 2 Hz high pass filter in MC_Rack.  

 Rack file: Cardiomyocytes_QT-Analysis_Demo.rck  
 Data file: Cardiomyocytes_QT.mcd  

4.3.4 Recording from human embryonic stem cell derived cardiomyocytes (hESC-CM) 

Cardiomyocytes from human embryonic stem cells develop a spontaneous beating pattern and  
can be used for basic research, for example, in the field of implantation medicine, or for drug 
screening, for example, for arrhythmogenic effects. hESC-CM present the most advanced model  
in cardiac in vitro physiology. Recorded extracellular field potentials resemble remarkably 
electrocardiogram signals. MEA recordings can be combined with other methods, for example, 
calcium imaging, optical recordings, patch clamp. This example data file shows the spontaneous 
activity of hESC-CM. (cell density: 10-15,000 cells per square mm, bandwidth: 1 Hz to 3.5 kHz, 
amplifier gain: 1200, voltage input range: -2000 mV to +2000 mV, sampling frequency 10 KHz, 
electrode diameter: 30 micrometer, electrode spacing: 200 micrometer)  

(Data kindly provided by Ofer Binah, Rappaport Institute, Haifa, Israel)  

 Rack file: hESC-CM_NoStim_Demo.rck  
 Data file: hESC-CM_NoStim.mcd  
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4.3.5 Pacing hESC-CM with electrical stimulation 

hESC-CM are usually paced at the lowest rate and voltage as possible, for example, a culture 
beating with 1 Hz would be paced at 950 ms rate with a typical biphasic stimulus pulse of  
+/-2 mV and 2 ms for each phase. For this experiment, MEA 200/30 with additional 4 pairs of large 
stimulating electrodes were used. Following the stimulus artifact, you can see the fast activation 
spike and the slow repolarization waveform. (cell density: 10-15,000 cells per square mm, 
bandwidth: 1 Hz to 3.5 kHz, amplifier gain: 1200, voltage input range: -2000 mV to +2000 mV, 
sampling frequency 10 KHz, electrode diameter: 30 micrometer, electrode spacing: 200 
micrometer) (Data kindly provided by Ofer Binah, Rappaport Institute, Haifa, Israel)  

 Rack file: hESC-CM_Stim_Demo.rck  
 Data file: hESC-CM_Stim.mcd  

4.3.6 Recording from HL-1 cell line 

The demo data used here was recorded from a cardiomyocyte cell line from mouse that retains  
a differentiated cardiac myocyte phenotype: HL-1 from Dr. W. Claycomb. The demo data file 
Cardiomyocytes_HL1.mcd was recorded from HL-1 cells at a sampling rate of 10 kHz with a gain  
of 1000, and a bandwidth of 1 Hz to 3 kHz.  

The signal rate and RR interval are graphed. 

 Rack file: Cardiomyocytes_HL1_Demo.rck  
 Data file: Cardiomyocytes_HL1.mcd  

4.3.7 Effect of Isoproterenol and E-4031 on mouse embryoid bodies 

This demo data file shows a complete drug testing experiment on a cardiac body derived  
from human embryonic stem cells. The cardiac body was developed on an MEA. Under control 
conditions, the signal rate was stable at about 0.75 Hz. 

During wash in of 10 μM Isoproterenol (applied at 64 s after recording start), the signal rate 
increased to 1.2 Hz. The effect was completely reversible by wash out (not recorded). As a result  
of the reduced RR interval, the QT interval was also decreased by 14 %. 

E-4031 had then been added (at 188 s) in a concentration of 100 nM (wash in not recorded).  
The QT interval was increased by 70 %. 

The demo data was recorded with an MEA1060 amplifier with a gain of 1200, and a bandwidth  
of 1 Hz to 3 kHz and an MEA-60-System, with a sampling rate of 10 kHz. Data was recorded in 
separate files and then merged to a single data file with MC_DataTool. The signal rate and the 
interspike interval (ISI) are graphed based on the automated signal detection in MC_Rack. 

 Rack file: Murine-ESC-CM_EB_Iso.rck  
 Data file: Murine-ESC-CM_EB_Iso.mcd  

4.3.8 Effect of Isoproterenol on human embryoid bodies 

The effect of Isoproterenol was tested on a cardiac body derived from human embryonic stem 
cells. The compound almost doubled the signal rate. The cardiac body was developed on an MEA. 
See also the MEA Application Note "Human Embryonic Stem Cell Derived Cardiac Myocytes  
(hESC-CM)". Under control conditions, the signal rate was stable at about 0.75 Hz. 

During wash in of 1 μM Isoproterenol (applied at 64 s after recording start), the signal rate 
increased to 1.2 Hz. The effect was completely reversible by wash out (not recorded). As a result  
of the reduced RR interval, the QT interval was also decreased by 14 %. 

E-4031 had then been added (at 188 s) in a concentration of 100 nM (wash in not recorded).  
The QT interval was increased by 70 %. 
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The demo data was recorded with an MEA1060 amplifier with a gain of 1200, and a bandwidth  
of 1 Hz to 3 kHz and an MEA-60-System, with a sampling rate of 10 kHz. Data was recorded in 
separate files and then merged to a single data file with MC_DataTool. The signal rate and the 
interspike interval (ISI) are graphed based on the automated signal detection in MC_Rack.  

(Data kindly provided by Dr. William Sun, ES Cell International, Singapore) 

 Rack file: hESC-CM_EB_Iso.rck  
 Data file: hESC-CM_EB_Iso.mcd  

4.3.9 Recording from chicken embryonic whole-heart 

The demo data shown here was recorded from an E13 chicken embryonic whole-heart preparation 
at a sampling rate of 10 kHz with a gain of 1200, and a bandwidth of 1 Hz to 3 kHz. The signal 
rate and RR interval are graphed. 

 Rack file: Cardio_WholeHeart_Chicken.rck  
 Data file: Cardio_WholeHeart_Chicken.mcd  

4.4 ME / in vivo - Offline/Demo Racks 

4.4.1 Chronic motor cortex recordings from rat 

Spike recordings were obtained from vibrissae motor cortex in a chronically implanted awake 
behaving rat. A custom-made platinum/tungsten (95/5%) electrode in glass with an impedance  
of 1 MOhm, an MPA8I, an FA64I (bandwidth: 300 Hz - 5 kHz, for spike recordings), and an  
ME64-System were used. One of the electrodes in the array was used as a reference electrode  
for the differential MPA8I amplifier. Total gain was 2000; the sampling rate was 20 kHz.  
(Data kindly provided by Dr. Cornelius Schwarz, University Tübingen, Germany) 

 Rack file: InVivo_Rat_Chronic.rck  
 Data file: InVivo_Rat_Chronic.mcd  

4.4.2 MicroEEG recordings with FlexMEA from rat barrel cortex 

Field potential recordings were obtained from the surface of the cortex, just above SIbf (Primary 
Somatosensory Cortex, barrel field), which is the primary somatosensory representation of the 
vibrissae of the rat. The acute experiment was done in an anaesthetized rat. The FlexMEA was 
kept in the same position during the experiment, but the mechanically stimulated vibrissa was 
varied. The resulting field potentials were analyzed after filtering the data with a digital low  
pass filter. The analysis of typical responses allows to locate the FlexMEA position relative to the 
positions of the barrels. This demo file shows the response to stimulation of one of the vibrissae.  

The FlexMEA was connected directly to an MPA32I with an FM-ADPT-32 adapter. An FA32I 
(bandwidth: 1 Hz - 5 kHz) was used as a filter amplifier. Recordings were made in MC_Rack  
with an ME-32 System. Reference electrodes in the array were used for the differential MPA32I 
amplifier. Total gain was 5000; the sampling rate was 20 kHz. The time stamps of the stimulus 
were recorded on the analog (not amplified) input channel A2. The Averager in MC_Rack was 
used to increase the S/N ratio. (Data kindly provided by Dr. Jean-Francois Léger, Ecole Normale 
Supérieure, Paris, France)  

 Rack file: InVivo_RatBarrelCortex_FlexMEA.rck  
 Data file: InVivo_RatBarrelCortex_FlexMEA.mcd  
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4.5 Online 

4.5.1 Continous monitoring and recording: Display_Continuous.rck 

This is a very basic sample rack that contains only a Data Display. You can use it for a first  
test of your MEA amplifier and noise level with the provided model test probe, for example.  
You will need a fully set up MEA-System for using this rack. 

4.5.2 Triggered recording: Display_Triggered.rck 

This is a very basic sample rack for recording triggered sweeps, for example after stimulation.  
The selected trigger input is bit 0 of the digital MC_Card input.  

Parameters: 

 Recorder: Start time (pretrigger) -100 ms, window extent (sweep time) 300 ms  
 Trigger Detector: Dead time 3 ms, digital input bit 0  

4.5.3 Basic rack for MEA1060-BC amplifier: MEA1060-BC.rck 

Basic rack for recording triggered sweeps with gain settings (1100) for a standard  
MEA1060-BC amplifier. 

4.5.4 Basic rack for double MEA layout: MEA-120-System.rck 

A basic rack with two raw data displays, one for each MEA. 

4.5.5 Basic spike detection: SpikeDetection.rck 

Demonstrates basic spike detection in Threshold mode. One display shows the raw data and  
the spike detection; the spike detection level can be adjusted for each channel separately. 

Both analyzers available in MC_Rack are used in this rack for extracting the spike rate: The 
standard Analyzer operates based on discrete time intervals (bins or region of interest). Extracted 
parameters are graphed in the Parameter Display. The event-based Spike Analyzer was specifically 
designed for extracting statistical parameters such as the interspike interval (ISI) or the rate from 
Spike data streams generated by the Spike Sorter. Extracted parameters are graphed in the Spike 
Analyzer Display.  

Parameters: 

 Recorder: Spike cutouts and spike rate selected for recording  
 Spike Sorter: Spike detection level for each channel  

4.5.6 Spike detection - threshold and slope mode: SpikeDetectionModes.rck 

This is a more advanced rack demonstrating both methods of spike detection in comparison:  
(a) Raw data is filtered by a high pass filter; spikes are detected by defining a threshold.  
(b) Spikes are detected by waveform (Slope mode) in unfiltered data. 

Parameters: 

 Spike Sorter (Threshold mode): Spike detection level for each channel  
 Spike Sorter (Slope mode): Slope and amplitude for all channels  
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4.5.7 Visualizing activity with software LEDs: Neuro_Spikes_LED_Display.rck 

Similar rack as SpikeDetection, but with an LED display. Analyzer extracts spike number in 10 ms 
bins. Spiking activity is indicated by lighting up of the corresponding electrode in the False Color 
"LED" display. Another display shows the spike cutouts. 

Parameters: 

 Spike Sorter (Threshold mode): Spike detection level for each channel  

4.5.8 Slope analysis of local field potentials: Neuro_LFP_SlopeAnalysis.rck 

This rack is based on the Triggered_Display rack. The slope of the sum potential is extracted  
from the region of interest (ROI), and then plotted vs. time. For example, for LTP experiments.  

Parameters: 

 Recorder: Start time (pretrigger) -100 ms, window extent (sweep time) 300 ms  
 Trigger Detector: Dead time 3 ms, digital input bit 0  
 Analyzer: ROI (after stimulus) 2-5 ms  

4.5.9 Recording spikes and field potentials in parallel: 
Neuro_Spikes+FieldPotentials.rck 

Rack for recording spikes and field potentials in parallel. A 300 Hz high pass filter removes 
separates field potentials from spikes, and vice versa. Spikes and spike rates are extracted  
from the high-pass filtered data; field potentials and peak-to-peak amplitudes are extracted  
from the low pass filtered data. An additional display shows the unfiltered raw data. 

Parameters: 

 Spike Sorter (Threshold mode): Spike detection level for each channel  

4.5.10 Digital filtering: Bandpassfilter.rck 

A combination of two digital filters acts as a bandpass filter: The first filter is a 300 Hz high pass 
filter, the following is a 3 kHz low pass filter, resulting in a total bandwidth of 300 Hz to 3 kHz. 
The display monitors the filtered and the unprocessed raw data. 

Parameters: 

 Filters: Adjustment of the cutoff frequencies  

4.5.11 LTP experiments: Neuro_LTP_analysis.rck 

For recording and analyzing LTP experiments. The Sync Out signal of the STG (stimulus generator) 
will be used for triggering the recording, with a pre-trigger of 30 ms and a time window of  
200 ms. Connect the Sync Out to the digital input bit 0 of the data acquisition computer. 

The Raw Data Display monitors the raw data. One Analyzer extracts the minimum and maximum 
of the response in region of interest I (shortly after the stimulus pulse), the other Analyzer extracts 
the slope of ROI II (the linear part of the falling edge of the field potential). As an example,  
the parameters are extracted only from channels 41 and 42. Please select the channels where you 
expect the largest response. Minimum and maximum are plotted versus time in a common display; 
the slope is plotted vs. time in a separate display.  
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Parameters: 

 Recorder: Start time (pretrigger) -30 ms, window extent (sweep time) 200 ms  
 Recorder: Channels of interest, for recording to hard disk  
 Analyzers and Parameter Displays: Channels of interest (41, 42) for extracting parameters,  

regions of interest  

4.5.12 Paired pulse facilitation (PPF): Neuro_PPF.rck 

In PPF experiments, the stimulus is followed by a second stimulus, typically 50-60 ms later.  
The amplitude of the sum potential of the neuronal response to the second stimuls is higher  
than to the first one. The Sync Out signal of the STG (stimulus generator) will be used for 
triggering the recording, with a pre-trigger of 30 ms and a time window of 200 ms.  
Connect the Sync Out to the digital input bit 0 of the data acquisition computer. 

In MC_Rack, two regions of interest (ROI) can be defined, one triggered by the first stimulus,  
the other by the second stimulus. The peak-to-peak amplitudes for both ROIs are extracted 
automatically and online. For triggering the two Analyzers, you could either use one of the 
additional Sync Out channels of the STG 2000 series, or you can use the standard recording  
trigger as well (as in this example). In this case, the dead time of the Trigger Detector should  
be set to a higher value (for example, 1000 ms) to make sure that only the first trigger input 
(correlating to the fist stimulus pulse) is used for triggering, and the second is skipped. 

Parameters: 

 Recorder: Start time (pretrigger) -100 ms, window extent (sweep time) 200 ms  
 Recorder: Channels of interest, for recording to hard disk  
 Analyzers and Parameter Displays: Channels of interest for extracting parameters, regions of interest  

4.5.13 Longterm experiments: SpikeRate_5minBins.rck 

The MEA-System and the flexible data stream management of MC_Rack is ideally suited for 
longterm experiments, for example 24 h monitoring of the spike rate, for days or even weeks. 

As demonstrated with this sample rack, the spike rate can be extracted in, for example,  
bins of 5 minutes, that is, the spike rate is continuously extracted in 5 min intervals.  

In this example, the spike cutouts, and the extracted spike rate is stored onto hard disk.  
To limit the file size, a new data file is generated each 4 hours. 

Parameters: 

 Recorder: Channels of interest, for recording to hard disk  
 Analyzer: Width of the time bin: 5 min, parameter of interest: Rate  

4.5.14 Cardio recording: Cardio_Averaging+ExcitationMap.rck 

The MEA-System can be used for in vitro studies of the electrical properties of cardiac myocytes 
and, for example, effects of drug candidates on field potential waveforms and kinetics. The two-
dimensional MEA layout is ideally suited for showing the waveform propagation and measuring 
the conduction velocity in a cardiomyocyte culture. The field potential duration corresponds to 
the action potential duration, that is, the QT interval in an electrocardiogram. It is measured from 
minimum of the Na+ peak to the maximum / minimum of the IKr current peak.  

If you study spontaneously active cultures, you can trigger the analysis based on the easily 
detectable sodium peak of any one channel, in this example, channel 51. Please select a channel 
that shows a very clear and regular waveform.  
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Based on this trigger, the Averager sums up the waveforms. The signal-to-noise ratio and signal 
quality improves significantly with each window that is summed up. For example, the IKr current 
peak (T wave) should be very clearly visible after 50 windows.  

The Analyzer extracts the maximum corresponding to the IKr current peak (T wave) following  
the sodium peak.  

Parameters: 

 Recorder: Channels of interest, for recording to hard disk  
 Analyzer and Parameter Display: Channels of interest for extracting parameters, region of interest  
 Averager: Number of summed up windows (50)  

4.5.15 Cardio recording: Cardio_SignalRate+RRInterval.rck 

This template rack shows how cardiac signals can be automatically detected with the Spike Sorter. 
The signal rate and the RR interval as parameters that characterize the beating rhythm are 
monitored online during the experiment, and are saved together with the raw data. The export 
features of the event-based parameter displays allow a direct export of the extracted parameters 
in universal ASCII format, or as a graphics file.  

In this configuration, the Spike Sorter operates in Threshold mode, that is, a signal is detected 
when the threshold is reached. The signal detection level can be adjusted for each recording 
electrode, according to the signal to noise ratio. The StdDev feature allows to automatically 
determine an appropriate threshold value for each channel in parallel, based on the standard 
deviation.  

The Spike Analyzer extracts the signal rate and the interspike interval. Both parameters are 
plotted over time in the Spike Analyzer Display.  

Parameters: 

 Recorder: Channels of interest, for recording to hard disk  
 Spike Analyzer: Channels of interest for extracting parameters, appropriate detection level for signal 

detection  
 Spike Parameter Display: Channels of interest for extracting parameters, x and y axes ranges  
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5 Getting Started 

5.1 First Steps in MC_Rack 

In this chapter, you will find a description of basic tasks and tools that are needed for all demo 
racks presented in the tutorial. Go through this chapter before you start building an application 
specific rack. 

You will learn in this chapter 

 How to start MC_Rack. 

 How to create a data file (Recorder). 

 How to replay previously recorded data (Replayer). 

 How to save a rack for future use. 

5.2 Starting MC_Rack 

 Double-click the MC_Rack icon or select MC_Rack from the Start menu. 
The program starts. One window opens automatically. This is your virtual rack configuration, 
which is blank after program start. Therefore, most commands and buttons are unavailable. 
You can choose from various software features, so-called virtual instruments, and assemble the 
virtual rack according to your specific application. You will learn in this tutorial how to set up 
racks for some typical applications. 

MC_Rack main window (empty) 

 



MC_Rack Tutorial: MEA Application Examples 

18 

The virtual rack 

The title bar shows the file name of the virtual rack (the default name before saving the rack 
under a custom name is Rack1). The white pane on the left of the virtual rack window holds  
the virtual rack tree view pane, where all virtual instruments that are part of this rack are 
represented by icons and (customizable) individual instrument names. 

After program start, the virtual rack is almost empty, it holds only a single virtual instrument  
the Recorder, represented by a small cassette player icon. The context-sensitive grey pane on  
the right shows the virtual instrument settings (organized in tab pages) of the virtual 
instrument that is selected (highlighted in blue) in the virtual rack tree view pane on the left.  
If you have added more instruments to the rack, you were able to click through the instruments  
in the tree view pane, and click the tabbed pages to review or change any settings. 

At this point, only the Recorder settings are available. The first Rack tabbed page is always  
the same for all virtual instruments here, you can start and stop MC_Rack (that is, the data 
acquisition or the Replayer), and activate the recording (that is, writing data to hard disk). 

The Lag status bar gives you information on the computer performance; the lower the Lag,  
the better the performance. When the Lag exceeds the maximum, MC_Rack will be stopped 
automatically, and you will be informed about a performance limit of the computer by an error 
message. The complexity limit of the virtual rack depends directly on the computer performance. 
To avoid data loss during over night recordings, for example, test the rack configuration 
thoroughly under realistic conditions (that is, the signal rate should be as expected in the real 
experiment) before starting the experiment. If you have trouble with the computer performance, 
please see the chapter Error Messages in the Troubleshooting section for more information on 
how to optimize the rack configuration. 

In the Recorder settings, you select the data streams and channels that you want to save  
to the hard disk. You define the path and the file in which the acquired data will be saved,  
and you define other parameters like the recording mode (continuous or triggered), and  
the maximum file size. 

The Recorder shows you the currently available disk space on the target hard disk. Please  
check the disk space and estimate how long you still can write data to the hard disk always  
before starting an experiment. Otherwise, data loss will occur when the disk is full. For example,  
if you record 60 electrode channels at a sampling frequency of 25 kHz, the data rate is 3 MB/s, 
that is 10.8 GB/h. 

 

MC_Rack toolbar. For a more detailed information on the toolbar buttons, please see "Toolbar" 
under General User Interface. 

The MC_Rack toolbar shows all main functions available in MC_Rack. You can click on a virtual 
instrument button to insert a virtual instrument into your rack configuration. Please note  
that virtual instruments that need an input data stream that is generated by another virtual 
instrument (for example, the Spike Analyzer, which needs a Spike data stream generated by  
the Spike Sorter) can only be placed in series with the required virtual instrument and are 
otherwise not available (indicated by a gray button color). In an empty rack, only the data source, 
that is, the data acquisition or the replayer, are available to start with. After the data source 
was inserted into the rack, other virtual instruments will be available. 
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5.3 Creating a Data File 

If you want to write the parameters that you will extract in an offline analysis to the hard disk, 
you have to specify the file name and path in the Recorder. (It is not possible to change or 
overwrite existing data files in MC_Rack, for example, adding the spike rate to an existing  
data file, but you can record the raw data together with the spike rate stream to the same file.) 

Choosing the file name and path 

1. Click the Recorder tab. 

2. Browse your folders and select a path. 

3. Type a file name into the text box. 

4. Confirm by clicking Save. 

The data file is then generated automatically when you start MC_Rack in recording mode.  
The file extension for the data files is *.mcd. 

 

File size limit 

When the maximum file size specified by the user has been reached, a new file is generated 
automatically. The file name is extended by four digits, counting up, for example  
LTP-Parameters0001.mcd, LTP-Parameters0002.mcd, and so on. 

If you rather prefer that the recording is completely stopped when a file has reached the 
maximum size, please select the option Auto Stop. 

For information on more options, please see "Generating Data Files" in the MC_Rack Features 
section. 

Selecting data streams and channels 

As has been said before, the fate of each single channel is independent from other channels. 
You can pick exactly the channels you like to save from all generated data streams. For example, 
you can decide to save only one channel of raw data, but the peak-to-peak amplitude results 
of all, or of a specific selection of channels. 
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 Click the Channels tab. 

As long as the rack is still empty, you see an empty box. There are no channels available at this 
point, because you have not chosen a data source yet (MC_Card for online data acquisition or 
Replayer for replaying data files). Without a data source, there are no data streams available  
for recording. Remember later, when you have completed the rack, to assign the channels that 
you like to save to the data file to the Recorder. 

After you added a data source, you will see the electrode raw data streams provided by the data 
source (for example, electrode raw data, analog data, and digital data from the MC_Card, or the 
data streams included in the data file loaded into the Replayer). If the rack file contains virtual 
instruments that generate data streams such as Spikes from a Spike Sorter or Parameter streams 
from an Analyzer, these data streams will be available for recording as well. 

5.4 Replaying Data 

In MC_Rack, the virtual rack configuration you use to record and analyze data online and offline, 
and the data files are in principle independent from each other. You can reuse a rack for 
several experiments and generate separate data files. You can then load the generated data file 
with another rack later for further offline analysis. We will be doing this now for demonstration 
purposes in this tutorial. (The general design of a rack is basically the same for online and for 
offline analysis.) 

Firstly, you define the input data (the data source). Because you will be doing an offline analysis 
with data saved previously, you need the Replayer. The Replayer works like a tape deck;  
you load a data file and you can then start and stop replaying the data streams by mouse-click. 
You can record the data streams you extracted in an offline analysis (for example, the spike rate, 
field potential amplitude, or digitally filtered data) by pressing the red Record button and then 
replaying the data file. 

1. On the toolbar, click  to add a Replayer to your rack. 
The Replayer property sheet opens. 
 

 

2. Click the Replay File tab. Here, you load the file you would like to review or to analyze offline. 
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3. Click Browse and browse your folders. Choose the desired file, for example, LTP-Demo.mcd  
or OTC Spikes Demo.mcd from the MC_Rack Sample Racks folder on the installation volume, 
and click Open or double-click the file name to open it. 
 

 
 
Later on, you can choose recently used files from the Recent Files drop-down list.  
Load a file by clicking Open. 

5.5 File Information 

Let us have a look at the file specifications of the data file loaded into the Replayer now. 

1. Click File Info. 
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2. You see the date and time when the data has been recorded and the sampling rate. 
The example screen shot shows that the LTP demo data was recorded triggered, that is,  
the data streams are not continuous, but the data has been cut out and recorded around  
a trigger event (in this case, the stimulus). The time window of each sweep has been set  
to 100 ms, and the recording has been started 30 ms before the trigger event. The total  
number of sweeps is 174.) The sampling rate was 20 kHz, and the input range of the 
MC_Card was set to +/4096 mV. The MC_Rack software version for recording was 3.3.0.2  
(this information might be required for support issues), and the name of the image file  
that was linked to the data file is LTP_slice. 

3. Click Buffer Info. 
On the left pane, you see the data streams  that are present in the data file. (In the example 
screen shot: Electrode Raw Data, and Trigger 2). Please see the chapter “About Data Streams”  
for more information. 

4. Click  to expand the data streams, for example Trigger 2. 
The example screen shot shows that the analog (not amplified, that is, gain = 1) channel A2 has 
been used as a trigger. In this case, the recording has been synchronized to the stimulus generator 
(STG) via the Sync Out of the STG. As long as the Trigger 2 data stream is selected (highlighted), 
you can see the parameters of the trigger, for example, the trigger detection level and the dead 
time of the trigger. 
 

 

5. Click Electrode Raw Data. 
You see that there are 60 channels present. 

6. Click  to expand the tree. You see the channel numbers according to the MEA layout. 
The gain for the electrode channels was set to 1100, the standard gain of the MEA1060-BC 
amplifier. 
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5.6 Starting Replaying and Recording 

When you have finished the virtual rack or if you have opened a preconfigured virtual rack  
from the Tutorial folder, you are ready to start the replaying and recording. 

 Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the data acquisition. Each virtual instrument in your rack starts to process the channels 
and data streams that were assigned to it. 

 Click first Record and then Start to write data to the hard disk. The data from the 
electrodes selected in the Recorder is saved to the file and location specified in the Recorder. 

 

 Click Stop to stop the replaying of data. 

 

Warning: Only data of the channels and data streams that were selected in the Recorder  
are saved in the data file when you start a recording. Data is only saved to the hard disk when  
the red Record button is pressed in. 
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6 Long Term Potentiation (LTP) 

6.1 Aim of Experiment 

 

This experiment was performed on an acute hippocampal slice on a Microelectrode Array 
(MEA) with 64 channels with the aim to analyze long-term potentiation (LTP) following 
electrical stimulation. 

The 300 μm thick acute hippocampus slice was prepared from a 21 days old rat. The slice was 
stimulated every 60 s with the test stimulus, a single biphasic pulse with 1.5 V amplitude  
and 100 μs duration per phase, by using one of the embedded MEA electrodes (No. 75). 
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Fig. 1 Test stimulus for LTP experiment 

The screen shot from the MC_Stimulus program shows the biphasic test pulse (amplitude: 1.5 V, 
duration: 100 μs per phase, inter-stimulus-interval: 60 s). The red trace is the Sync Out (TTL) pulse 
that was used for triggering the recording. 

LTP was induced by an LTP train with 100 pulses of same amplitude and duration as the test 
stimulus, and a frequency of 100 Hz. The Sync Out signal of the STG (stimulus generator) has been 
used to trigger the recording, with a pre-trigger of 30 ms and a time window of 100 ms. Data was 
recorded before and after the LTP induction; the LTP induction itself was not recorded. 

 

Fig. 2 Pulse train of 100 biphasic pulses for LTP induction 

Amplitude: 1.5 V, duration: 100 μs per phase, inter-stimulus-interval/frequency: 10 ms / 100 Hz) 

As the data was acquired with a MEA1060-BC amplifier with blanking circuit, all MEA electrodes 
were disconnected from the amplifier shortly during stimulation, in this case for 540 μs  
(300 μs Sync Out pulse of the STG, plus intrinsic Wait of 40 μs, plus user-defined Wait of 200 μs). 
This efficiently prevented stimulus artifacts. 

The demo data used in this part of the tutorial was kindly provided by Dr. Frank Hofmann, 
University of Heidelberg, Germany. 
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Task 

Show the impact of an LTP train on the LTP peak-to-peak amplitude by an offline analysis; graph, 
print and save the results. 

Note: In this chapter, you will set up an offline analysis rack (for the demo data file) step by step. 
You can set up a virtual rack for online recordings and analysis likewise, simply add the MC_Card 
as the data source to the rack instead of the Replayer. 

 Rack file: Neuro_LTP_Demo.rck  

 Data file: LTP-Demo.mcd (recorded after LTP induction) , preLTP-Demo.mcd (recorded before 
LTP induction)  

 Image file: LTP_slice.jpg 

Please see also the MEA Application Notes for more information on the preparation techniques 
and experiments. 

You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Record data (Recorder) 

 Analyze field potentials, for example, extract peak to peak amplitudes (Analyzer) 

 Plot the amplitude vs. time (Parameter Display) 

 How to customize the rack: 

 Modify the display layout (all display types) 

 Rename virtual instruments for a better overview (all virtual instruments) 

 More details: 

 Align the data traces to a slice picture (Analyzer, Data, or Averager display) 

 Customize the colors of the traces and axes in the display (all display types) 
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6.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file "Neuro_LTP_Demo.rck". Click Open on the 
File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder from the installation volume into the MC_Rack 
program directory with the following path "c:\Program Files\Multi Channel Systems\MC_Rack\" 

2.  Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file LTP-Demo.mcd into the Replayer. 

 

6.3 Analyzing Field Potentials 

You can use a virtual Analyzer for extracting parameters of interest, for example,  
the minimum or maximum, the amplitude, or the slope from a region of interest (ROI)  
of the field potentials. 

As the data was recorded on a trigger (the Sync Out pulse of the stimulator) and the region  
of interest needs to be specified relative to a trigger event, the Analyzer will also operate based 
on this trigger. In an online experiment, you would now have to define the trigger with a Trigger 
Detector. In the data file, the trigger was already recorded together with the raw data, and  
you can use the existing trigger for triggering the Analyzer. (In this experiment, more than  
one trigger were used, but trigger 2 was used for recording the data, trigger 1 was not saved. 
Therefore, there is only trigger 2 available in the data file.) You can see this information on the 
File Info page of the Replayer. 

1. On the toolbar, click  to add an Analyzer to the virtual rack configuration. 

2. Select now the channels you are interested in. Start with all channels, you can then later decide to 
deselect channels with no LFP responses (for optimizing the computer performance). For example, 
you can deselect the stimulating electrode No. 75, or electrodes that are not covered by the slice. 
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3. In the tree view pane of the virtual rack, select the Analyzer and click the Channels tab  
of the Analyzer. 

4. Click the data stream Electrode Raw Data. On the right half of the Channels page,  
the channels appear in the standard 8 x 8 MEA grid. 

5. Select the check box next to the stream name to select all channels or click the buttons with  
the electrode numbers to pick single channels. The check box next to the stream name appears 
shaded if some, but not all channels have been selected. 
 

 

6. Click the ROI tabbed page, which stands for region of interest. Start on Trigger 2  
is preselected, because the recording of this data file was triggered on trigger 2. The option 
Continuous is not available, because the sample data is not a continuously recorded file. 
 

 
 
The Analyzer displays the electrode channels in the layout of the Channel Map  
you have created or loaded. 
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6.4 Customizing the Display Layout 

The following information applies not only to the Analyzer display, but also to other displays, 
such as the Raw Data display or the Parameter display. 

Hint: Channel maps are provided for all MEA types available from Multi Channel Systems. You can 
download channel maps for all MEAs available from Ayanda Biosystems from the Ayanda web 
site (http://www.ayanda-biosys.com/download.html). You can also set up custom channel maps 
with a preselected number of electrodes and save them for later use. 

1. In the tree view pane of the virtual rack, select the Analyzer and click Layout. 

2. To load a Channel Map in the MEA layout, click Open. 

3. Browse your folders and open the MC_Rack program folder. 

4. Select the appropriate MEA layout, for example, the 8x8mea.cmp file for standard 8 x 8 MEAs, 
and click Open. The MEA layout appears on the right side of the dialog box, and the 
corresponding display is updated accordingly. 
 

 

5. Switch to the Analyzer display. You can choose the appropriate range of the y-axis from the 
drop-down list. The x-range and the display refresh rate are defined by the sweep time. You  
can see on the File Info page of the Replayer that the data is triggered and that one sweep  
is 100 ms long. Therefore, the maximum range of the x-axis is 100 ms. You can fine-tune the 
ranges with the sliders. 
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6.5 Renaming Virtual Instruments 

You can rename instruments for a better overview. This is especially useful if you use the same 
type of virtual instrument several times, for different purposes, in the same rack. 

1. In the tree view pane of the virtual rack, select the Analyzer 1, and then click its name  
(do not double-click it). An insertion point appears. 
 

 

2. Type in the new name, for example Peak-Peak Amplitude. 

6.6 Zooming into a Single Channel 

In all displays, you can switch to a single channel by double-clicking the channel in the display. 

1. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 
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2. Double-click channel No. 65 in the Analyzer display. As the pathway that is going to be analyzed 
in this experiment is directed from the right to the left in the slice, the electrodes of interest are 
left of the stimulating electrode. 
 

 
 

The magnifying-glass icon  on the top left indicates that you have zoomed to a single channel. 

3. Zoom in the y-axis by moving the two sliders to each other. 
 

 

4. Move the range by clicking in the middle between the two sliders and dragging with your 
mouse or pressing the LEFT ARROW and the RIGHT ARROW keys. For larger steps, you can also  
use the PAGE UP / PAGE DOWN keys. 

5. Zoom the x-axis as well until you have centered on the response following the stimulus  
(at time point 0). 
 

 

6. Double-click the display again to switch back to the full channel view. 
The settings have been applied to all channels. 
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6.7 Aligning the Data Traces to a Slice Picture 

You can load a digital photograph of the acute slice as a background picture and align the signals 
to the electrodes and the regions of the slice. 

Hint: Crop the picture in a graphics program so that only the electrode array is visible.  
This helps saving (unused) space on the screen. 

1. On the File menu, click Load Image. 

2. Browse your folders and open the Tutorial folder on the installation volume. 

3. Select the LTP_slice.jpg file and click Open. 

4. On the Analyzer or Data Display, click Show Image. 
You can now see the slice picture. 

5. Now, you map the channels to the electrodes in the picture. Hold down the SHIFT key,  
point to any electrode in the picture, for example No. 77, and double-click. 
 

 
 
A text box opens. 

6. Type in the number of the electrode according to the MEA layout, for example 77. 

7. Hold down the CTRL key, point to any electrode in another row and column,  
for example No. 44, and double-click. 

8. Type in the number of the electrode according to the MEA layout, for example 44. 
The data traces appear on top of the picture. 
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9. You can resize the window by dragging the window frame with the mouse. 
The graphic will be scaled accordingly. 
 

 

Note: If you have made a mistake, simply repeat the assignment from step 58. 

Hint: If you record data with a background picture in your rack, the file path of the picture  
is saved together with the data, that is, it is opened automatically when you replay the file  
in a rack that has a Display with the Show Image option selected. (File paths are absolute,  
that means MC_Rack cannot find picture files if they have been moved to another folder or 
directory. You will be informed by an error message.) 
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6.8 Customizing the Display Colors 

It may be difficult to see the traces or the axes because the contrast of the trace color to the 
background color is too low. You can define the colors of the traces and the axes to improve  
the view. 

1. Point to any trace or to an axis and right-click. 
The Color dialog box opens. 
 

 

2. Choose a color from the palette or set up a custom color. 
The color of all traces or of the axes is changed accordingly. 

6.9 Extracting Parameters 

In triggered mode, the Analyzer extracts the parameters of interest from a distinct time 
window relative to the trigger event, the region of interest (ROI). It is very important  
to define this time frame appropriately for all channels of interest, because otherwise you  
will not obtain any proper results from the Analyzer. 

1. In the tree view pane of the virtual rack, select the Analyzer, and click the Analyzer tab.  
Select the parameters you like to extract, Peak-Peak Ampl. in this case. 
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2. Now, you have to define the ROI. Look at the Raw Data traces again in the Analyzer display and 
select a range that includes the biological responses on all channels. Shortly after the stimulus / 
trigger event (time = 0) will be fine. You can define the region of interest with by dragging the 
two vertical bars in the display, or by editing the T1 and T2 boxes on the ROI tabbed page of the 
Analyzer. For example, the start time (= T1) can be set to 1 ms (after the trigger event) and the 
stop time (= T2) 41 ms. 
The selected parameters of interest will then be extracted from the region of interest, and can 
then be recorded to a data file, and / or plotted using a Parameter display. 

 

 

6.10 Plotting Amplitude versus Time 

Add a display to graph the peak-to-peak parameter. As a parameter data stream is very different 
from raw data, MC_Rack features a specialized display type, the Parameter Display, which is 
optimized for parameter streams. 

 In the tree view pane of the virtual rack, select the Analyzer and click  on the toolbar to add  
a Parameter Display in series with the Analyzer to the virtual rack. (It would not be possible  
to add the Parameter Display in parallel to the Analyzer, as the replayed data file does not 
contain any parameter streams as input streams for the display, and virtual instruments can only 
use the output streams of other virtual instruments that are upstream in the virtual rack tree.) 
Rename the display to Amplitude vs. Time. 
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Customizing the display layout 

You can define the layout for each display separately. If you have selected all channels as an input 
for the analyzer, you may want to see the plot for all channels as well, for example. On the other 
hand, you may be interested in monitoring only one or two representative channels online  
(for saving space on the screen or for saving computer performance). (You can still save the 
parameters of all channels in the data file to review it later or to analyze it further in your 
custom evaluation software.) Set up a custom layout with only one electrode of interest now. 

Hint: Try typing the channel numbers instead of selecting them from the drop-down list  
with the mouse.  

1. Click the Layout tab. 
The default layout is loaded. In the Rows and Columns boxes, you can now modify the layout. 

2. Type or select the number of Rows, for example 1, and the number of Columns, for example 1. 
On the right, a custom layout with a single channel appears. 

3. Assign the appropriate channel numbers to the empty slots. Click the empty slot to select it.  
The active slot is highlighted by a dotted line. 

4. Select 65 for the active slot from the Channel list, or type 65. 
The Parameter Display is updated accordingly. Likewise, you can set up any custom 
configuration for all display types. 
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Selecting data streams 

Now, select the data that you like to be displayed. 

1. Click the Data tab. 
The Peak-to-Peak Amplitude is already preselected. The plot type is set to Trace, meaning  
that a curve is plotted. These settings are ok and do not have to be modified in the moment. 
 

 

Setting the window extent 

As you can see on the File Info page of the Replayer, the total recording time of the example 
file is about 3 hours. Adjust the ranges of the y-axis as well. 

1. Click the Ranges tab. 

2. Enter 3 h for the x-axis range, and 4 mV for the y-axis. 
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1. Click Start  to graph the plots. The baseline and the LTP induction were not recorded.  
The high amplitudes at the beginning demonstrate the effect of short term potentiation. LTP 
starts after about 20 min following the LTP induction. The amplitude slowly decreases over time. 
 

 

6.11 Zooming and Scrolling 

Zooming to a single channel 

To provide an overall view of the ongoing activity, normally all channels (depending  
on the layout) are shown in the parameter display. 

 Simply double-click a channel to have a closer look at it. The magnifying glass icon   
in the upper left corner indicates the zoom mode. 
 
Double-click the zoomed channel again to switch back to the overall view. 

Scrolling back and forward 

You can scroll the data forward and backward along the time axis. You are able to look  
for a region of the plot you are interested in and snapshot the displayed region. 

 On the tool bar, click  to scroll backward and  to scroll forward. 

 Click  if you like to jump to the beginning of the plot. 

 Click  if you like to jump to the end of the plot. 

Scaling the x- and y-axis 

You can zoom the x- and y-axis in and out separately. The left button array on the toolbar 
corresponds to the x-axis and the right button array to the y-axis. 

 Decide which axis you like to scale and click the corresponding  button to zoom the axis  

in and  to zoom it out. The display will be updated accordingly. 

 To reset the scaling of the x-axis to default, click . 

 Likewise, click  to reset the scaling of the y-axis. 
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 If you have zoomed to a single channel, you can click the Apply to All button  to apply the 
settings to all channels. If you do not use this button and switch back to the overall view, any 
changes to the settings are lost. 

6.12 Saving a Picture 

You can take a screen shot of the Parameter Display. This feature is especially useful for  
quickly setting up illustrations and presentations. Each visible channel on your display is saved  
as a separate image file. Each file has the chosen file name extended by channel number.  
If, for example, the entered file name is Peak-to-Peak, the file name of channel 41 will be  
Peak-to-Peak_41.jpg. 

Note: Only the channels that are currently shown on the display are captured. Therefore,  
if you want to capture all channels, click the Snapshot button when all channels are visible.  
If you want to capture only a single channel, zoom this channel and then click the Snapshot 
button. 

Hint: If you need more features for data screen shots, Multi Channel Systems recommends  
to use a commercially available screen shot program. 

1. On the Parameter Display toolbar, click the Snapshot button  to take screen shots  
of the displayed channel(s). The Save As dialog box opens. 

2. Select an image file format from the drop-down list: 
(*.emf), Enhanced Meta File format (vector graphics) 
(*.bmp), bitmap 
(*.jpg), compressed bitmap in JPEG format 

3. Enter a file name. 
 

 
 
The file name will automatically be extended by the channel number. 

4. Confirm by clicking Save. 
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6.13 ASCII Export 

You can save the displayed data as an ASCII file (text without formatting). You may then send 
this data to an editor or to your custom analyzing software, for example. This feature is also very 
convenient if you want to generate custom graphics, for example, with Microsoft Excel or 
Micrococcal Origin. 

Saving data is only possible when you have stopped the recording. The Save button will reappear 
on the toolbar. 

Note: Only the channels that are currently shown on the display are saved. In the example given 
below, only the Peak-to-Peak amplitude of the channel 65 will be saved. Therefore, if you want  
to save all channels in a single file, click the Save button when all channels are visible. If you 
want to save the parameter values of a single channel only, zoom this channel and then click  
the Save button. 

Hint: If you need more features, for example, export of raw data, use the add-on program 
MC_DataTool that comes together with ME- / MEA-Systems. 

1. Click the Save button  on the Parameter Display toolbar to open the Save As dialog. 
The Save As dialog box will be opened. 

2. Type in a file name and path and click Save. 

 

You can now open and process the file with any text editor, spreadsheet, or any other custom 
evaluation software. The following screen shot shows how it looks when the filet is opened  
with a standard spreadsheet. The first row contains the axes headers. The first column contains 
the x-values (in hours), the second column the y-values of channel 65 ( in microvolts). 
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6.14 Recording Analyzed Data 

Now, the virtual rack for offline analysis of LTP experiments has been completed, and you can 
select the data that should be recorded, that is, saved in the generated data file. It is important  
to know that MC_Rack never modifies or overwrites an existing data file. That means, in an 
offline analysis, the extracted parameter streams are stored in a new data file. Therefore, you 
need to specify a file name and path in the Recorder for both online and offline analysis. 

Hint: If you want to store raw data and extracted parameters in the same data file, you can select 
the already existing raw data traces in a replayed file for rerecording them together with the 
extracted parameter streams. 

1. Select the Recorder and click the Channels tab. 
You see all data streams on the left. You can now select any channels you like, independently 
from the channels you view on screen with MC_Rack. To select the Electrode Raw Data stream 
does not make much sense in this case, because the data file already exists and is only replayed  
in this tutorial. But if you performed an online analysis, you would probably want to save the  
raw data (cutout sweeps triggered on the stimulus) of the relevant channels. 

2. In this case, we are interested in the Peak to Peak parameters. Select the Parameter 1 data 
stream. All available channels appear in a button array on the right side. (Remember: Available 
are those channels that have been assigned to the Analyzer and thus have been processed by  
the Analyzer. If you change the Analyzer input, you will see that the recordable output will  
be changed accordingly.) 

3. Select all channels by selecting the check box, or pick single channels. All channels selected  
on this page will be saved in the specified file when you start the recording. (If you have not 
already specified the file and path on the Recorder tabbed page, do so now.) 
 

 
 
Click the Record button and then Start again. 
 

 

4. The data will now be replayed and the selected data streams will now be saved to the specified 
location. You can then replay the newly generated file with the Replayer and a Parameter 
Display. You can also export the data to your custom graphics or analysis software. 

Note: Do not forget to enable the recording by clicking the Record button  !  
Otherwise, no data will be stored. 
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7 Input/Output (I/O) Curve 

7.1 Aim of Experiment 

 

This example file was recorded from an acute hippocampal slice on a Microelectrode Array 
(MEA) with 64 channels with the aim to analyze the input-output (I/O) relationship of the 
biological response to the electrical stimulation. The magnitude of the synaptic response  
is relevant in this experiment. It can be assessed based on the minimum or peak-to-peak 
amplitude of the field excitatory postsynaptic potential (fEPSP) or on the slope of the initial 
response decay. The latter has the advantage that it is a more linear measure of the EPSP strength 
when population spikes mask the fEPSP. It is, however, more sensitive to noise and more difficult 
to extract with propagating waves of activity. 

The biological sample was 300 μm thick and stemmed from a 22 days old rat. The tissue was 
stimulated with one of the substrate integrated electrodes (# 65). A monopolar electrical 
stimulation with biphasic voltage pulses (duration of 100 μs per phase) with amplitudes from  
500 to 3000 mV, in 250 mV steps, was applied. Individual voltage steps were repeated 5 times  
with a delay of 5 s, that is, 5 x 500 mV, then 5 x 750 mV, then 5 x 1000 mV, and so on.  
The Sync Out signal of the STG (stimulus generator) was used to trigger the recording sweeps, 
with a pre-trigger of 10 ms and a time window of 70 ms.  

This example shows a recording with the new MEA amplifier with blanking circuit (MEA1060-BC), 
featuring a superior stimulus artifact suppression. The Sync Out signal of the STG also triggered 
the MEA amplifier. The electrodes were transiently, in this case for 540 μs (300 μs Sync Out pulse 
of the STG, plus intrinsic Wait of 40 μs, plus user-defined Wait of 200 μs) separated from the 
amplifier stage during stimulation. Stimulus artifacts could be efficiently prevented on all 
recording channels. 
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The demo data used in this part of the tutorial was kindly provided by Dr. Frank Hofmann, 
University of Heidelberg, Germany. 

Task 

Analyze the input-output (I/O) relationship of the biological response to the electrical 
stimulation by an offline analysis; graph, print and save the results. 

Note: In this chapter, you will set up an offline analysis rack (for the demo data file) step by step. 
You can set up a virtual rack for online recordings and analysis likewise, simply add the MC_Card 
as the data source to the rack instead of the Replayer. 

 Rack file: Hippocampus_IOCurve_Demo.rck  

 Data file: I-Ocurve_Demo.mcd  

 Image file: Hippocampus_IOCurve.jpg 

Please see also the MEA Application Notes for more information on the preparation techniques 
and experiments. 

You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Select electrodes of interest / deselect unused electrodes. 

 Analyze field potentials, for example, extract peak-to-peak amplitude and the slope  
in parallel (Analyzer) 

  Plot the extracted parameters vs. time (Parameter Display) 

 How to customize the rack: 

 Modify the display layout (all display types) 

 More details: 

 Align the data traces to a slice picture (Analyzer, Data, or Averager display) 

7.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file "Hippocampus_IOCurve_Demo.rck".  
Click Open on the File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder into the MC_Rack directory with the following path 
"c:\Program Files\Multi Channel Systems\MC_Rack\"  

2. Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file I-Ocurve_Demo.mcd into the Replayer. 
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7.3 Extracting the Peak to Peak Amplitude 

1. For extracting the peak-to-peak amplitude and the slope, we will need an Analyzer.  

Click  on the toolbar to add an Analyzer to the virtual rack. 
 
The triggered Analyzer display with the region of interest appears because the data was 
recorded as triggered sweeps. 

2. Rename the Analyzer to Peak to Peak to distinguish it from the slope analyzer that we will  
set up later. 

3. Select the Analyzer in the tree view pane. Select the parameters you like to extract,  
Peak-Peak Ampl. in this case. 

 

7.4 Aligning the Electrode Pattern to the Slice 

You can load a picture (from a digital camera, for example) of the acute slice as a background 
picture of the display and align the traces to the electrode positions. 

1. On the File menu, click Load Image. 

2. Browse your folders and open the Tutorial folder on the installation volume. 

3. Select the Hippocampus_IOCurve.jpg file and click Open. 

4. On the Analyzer window, click Show Image. 
You can now see the slice picture. 
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5. Now, you map the channels to the electrodes in the picture. Hold down the SHIFT key,  
point to any electrode in the picture, for example, No. 33, and double-click. 
 
 

 
 
A text box opens. 

6. Type in the number of the electrode according to the MEA layout, for example 33. 
 

 

7. Hold down the CTRL key, point to any electrode in another row, for example the bottom right, 
and double-click. 

8. Type in the number of the electrode according to the MEA layout, for example 78. 
The electrode numbers appear on top of the picture in the typical 8x8 grid. 
  

9. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 
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The data traces appear on top of the picture. 

 

Note: If you have made a mistake, simply repeat the assignment from step 58. 

Hint: If you record data with a background picture in your rack, the file path of the picture  
is saved together with the data, that is, it is opened automatically when you replay the file  
in a rack that has a display with the Show Image option selected. (File paths are absolute,  
that means MC_Rack cannot find picture files if they have been moved to another folder or 
directory. You will be informed by an error message.) 

7.5 Deselecting Unused Electrodes 

One of the main advantages of MC_Rack is the flexible data management. You can now deselect 
any unused electrodes, for example, the electrodes that are not covered by the slice or the 
stimulating electrode, in the Analyzer, so that the peak to peak amplitude is extracted only  
from the selected electrodes. 

Hint: With a MEA Switch, you could use unused channels on the data acquisition board for 
recording from an additional amplifier. 

Note: The Recorder that writes data to the hard disk is an independent virtual instrument,  
that is, you have to select the channel numbers that you want to save in the generated data file, 
for each data stream separately, on the Channels tabbed page of the Recorder. 

1. In the tree view pane of the virtual rack, select the Analyzer, and click the Channels tab. 

2. Click the data stream Electrode Raw Data. 
On the right half of the Channels page, the channels appear in the MEA-layout. You can select 
the check box next to the stream name to select all channels, or click single buttons to pick single 
channels. The check box next to the stream name appears shaded if some, but not all channels 
have been selected. 

3. Deselect the stimulating electrode 65, and all unused electrodes such as 21, 31, 32, 33, 34, 35, 36, 
37, 52, 62, 72, 82, 73, and 83, by clicking the corresponding channel buttons. Selected channel 
buttons appear pressed in. 
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If you start the rack again, only the traces from selected electrode are displayed  
(and only the peak to peak amplitudes from selected electrode channels are extracted). 
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7.6 Defining the Region of Interest 

You have to define a time range relative to the trigger event as the region of interest (ROI).  
The parameter of interest, the peak-to-peak amplitude in this case, is then extracted from the 
data trace in the region of interest. You can define the region of interest with the two vertical 
bars in the Analyzer display or by editing the T1 and T2 boxes on the ROI tabbed page of the 
Analyzer. 

1. Double-click on any electrode with a large response to zoom into the data recorded  
from this electrode. 
 

 
  

2. Position the bars so that the field potential is clearly inside the region of interest.  
As the demo data was recorded with a MEA1060-BC amplifier with blanking circuit,  
there is no stimulus artifact that you would need to exclude from the analysis. 
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7.7 Plotting the Intensity of the Biological Response 

As a measurement for the response to the stimulus, we will plot the peak-peak amplitude  
and the slope versus time. We will start with the peak-peak-amplitude. For graphing  
the extracted data, we will need a Parameter Display. 

 In the tree view pane of the virtual rack, select the Analyzer and click  on the toolbar to add  
a Parameter Display in series with the Analyzer to the virtual rack. (It would not be possible  
to add the Parameter Display in parallel to the Analyzer, as the replayed data file does not 
contain any parameter streams as input streams for the display, and virtual instruments can only 
use the output streams of other virtual instruments that are upstream in the virtual rack tree). 
You can rename it so that you can identify it later in the virtual rack. 

Setting the window extent 

As this demo data file has about 4 min recording time (see File Info page of the Replayer),  
5 min will be fine for the x-axis range. 

1. In the tree view pane of the virtual rack, select the Parameter Display, and click the Ranges tab. 

2. Enter 5 min for the x-axis range, and adjust the y-axis to the maximum response, for example, 
3000 μV. 
 

 

1. Click Start  to generate the plots. You can select the option Display Marker to mark  
each extracted data point in the plot. 
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The output is nicely increasing with the increasing stimulus amplitude. 

 

7.8 Extracting the Slope 

In triggered mode, the Analyzer extracts the parameters of interest from a distinct time 
window relative to the trigger event, the region of interest (ROI). You could use the same 
Analyzer for extracting both the peak-to-peak amplitude and the slope, but as two distinct 
regions of interest are required for extracting the two parameters, we will need to set up a 
second Analyzer. 

1. Click  on the toolbar to add a second Analyzer to the virtual rack. 

2. Rename the Analyzer to Slope to distinguish it from the first analyzer. 

3. In the tree view pane of the virtual rack, select the Analyzer, and click the Channels tab.  
Select the electrode channels that you would like analyze, for example, channel 55. 

4. Click the Analyzer tab and select the parameters you like to extract, slope in this case. You have 
the choice between four options: Slope is the slope of a straight line fitted through all data 
points in the ROI. When choosing Slope 10% / 90%, only the data points in the range of  
10% / 90% of the peak-peak amplitude (stretching from minimum to maximum) in the region  
of interest is considered for fitting the line. This is generally more useful as the exact timing of the 
regions of interest may differ slightly from channel to channel and it might be difficult to position 
the ROI to fit all channels of interest. 



MC_Rack Tutorial: MEA Application Examples 

52 

Select checkbox slope 10% / 90%. 
 

 

Defining the ROI 

For extracting the slope, you need to frame ideally only the linear part of the response  
decay with the ROI cursors. 

1. Zoom into a single channel and use the sliders to adjust the ranges so that you can clearly  
see the linear part of the response decay. 
 

 

2. Define the region of interest with the vertical bars T1 and T2. When choosing the Slope 
10%90% option, it is not required to position T1 and T2 exactly, as 10 percent, that is, the non-
linear part of the response, is not regarded.  
The slope is then computed from a linear fit regression line (Least Square Algorithm) in the ROI. 
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7.9 Customizing Displays 

As it may not be useful or possible to extract the slope from all channels, you can set up your 
custom layout for the Analyzer or the Parameter display (this is true for all displays), to save 
space on the screen. You may be interested only in one or two representative channels. 
(Remember: You can save the parameters of all channels in the Recorder to review it later  
or to analyze it further in your custom evaluation software.) 

1. Click the Layout tab. 
The default layout is loaded. In the Rows and Columns boxes, you can now modify the layout. 

2. Type or select the number of Rows, for example 1, and the number of Columns, for example 1. 
On the right, a custom layout with a single channel appears. 

3. Assign the appropriate channel numbers to the empty slots. Click the empty slot to select it.  
The active slot is highlighted by a dotted line. 

4. Select the channel of interest, for example, 55, for the active slot from the Channel list,  
or type 55. The Parameter Display is updated accordingly. Likewise, you can set up any  
custom configuration for all display types. 
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7.10 Plotting a Slope Curve 

1. On the toolbar, click  to add a second Parameter Display following the second Analyzer  
to the virtual rack configuration. (If it follows the first Analyzer in the tree view, it will not be 
possible to assign the output data stream of the second Analyzer, that is, the slope, to this 
Parameter Display.) You can rename it so that you will identify it later in the virtual rack. 

2. Adjust the x-axis range to the total recording time of about 5 minutes. 
 

 

3. Start the rack to generate the plot. 

The slope becomes more negative, that is, the decay time decreases, with an increasing  
stimulus amplitude. 
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8 Paired Pulse Facilitation (PPF) or Depression (PPD) 

8.1 Aim of Experiment 

 

In Paired Pulse Facilitation (PPF) or Depression (PPD) experiments, the stimulus is followed  
by a second stimulus, typically 2080 ms later. The magnitude of the population response to the 
second stimulus is compared to that of the first one. It is higher in case of a PPF, or lower in case 
of a PPD. 

In MC_Rack, two (or more) regions of interest (ROI) can be defined, one triggered by the first 
stimulus, the other by the second stimulus, for example. The peak-to-peak amplitudes for both 
ROIs can be extracted online. 

The example data file was recorded from a 300 μm thick acute hippocampus slice that  
was prepared from a 32 days old rat. The slice was stimulated with a single biphasic pulse  
(2 V amplitude, 100 μs per phase) by one of the embedded MEA-electrodes (No. 64). The second 
stimulus pulse was applied 20 ms following the first one. Recording was triggered by applying  
the Sync Out signal of the stimulus generator to one of the analog input channels (A1). Recorded 
sweeps are 200 ms, with a pre-trigger time of 30 ms, and a post-trigger time of 170 ms. 

As the data was acquired with a MEA1060-BC amplifier with blanking circuit, all MEA electrodes 
were disconnected from the amplifier shortly during stimulation, in this case for 540 μs  
(300 μs Sync Out pulse of the STG, plus intrinsic Wait of 40 μs, plus user-defined Wait of 200 μs). 
This efficiently prevented stimulus artifacts. 

Some electrodes recorded PPF and others PPD in this demo data file. 

The demo data used in this part of the tutorial was kindly provided by Dr. Frank Hofmann, 
University of Heidelberg, Germany. 



MC_Rack Tutorial: MEA Application Examples 

56 

Task 

Extract the field potential amplitude from two distinct regions of interest by an offline analysis; 
graph, print and save the results. 

Note: In this chapter, you will set up an offline analysis rack (for the demo data file) step by step. 
You can set up a virtual rack for online recordings and analysis likewise, simply add the MC_Card 
as the data source to the rack instead of the Replayer. 

 Rack file: Neuro_PPF_Demo.rck 

 Data file: PPF_Data.mcd 

 Image file: PPF_Image.jpg 

Please see also the MEA Application Notes for more information on the preparation techniques 
and experiments. 

You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Trigger MC_Rack on a TTL pulse (Trigger Detector) 

 Extract the peak-to-peak amplitude from two distinct regions of interest (Analyzer) 

 Plot the amplitude vs. time (Parameter Display) 

8.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file "Neuro_PPF_Demo.rck". Click Open on the 
File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder from the installation volume into the MC_Rack 
program directory with the following path "c:\Program Files\Multi Channel Systems\MC_Rack\" 

2.  Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file PPF_Data.mcd into the Replayer. 
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8.3 Triggering MC_Rack on the Stimulus 

The analog input channel A1 was used to feed in the TTL signal from the Sync Out channel  
of the stimulus generator. You can use this TTL pulse to trigger the Recorder or any other  
virtual instruments. (As the trigger data stream was saved together with the data file, you can  
of course also use this trigger for replaying the data as well, but we recommend to set up a 
Trigger Detector on your own in this tutorial to learn how to do it.) 

Note: It is recommended to use the digital input port for feeding in TTL signals. The analog inputs 
are intended for analog signals, like patch clamp data, for example. 

1. Click  on the toolbar to add a Trigger Detector to the virtual rack. 
The Trigger Detector is automatically named Trigger Detector 3, as the replayed data file 
already contains 3 trigger data streams, so the data stream generated by this new Trigger 
Detector will be Trigger 4. You can rename it if you wish. 

2. In the tree view pane of the virtual rack, select the Trigger Detector, and click the Trigger page. 

3. From the Channel list, select the Analog Raw Data A1 channel, to which the Sync Out channel 
of the stimulus generator was connected. 

4. Enter a threshold. As the TTL signal has a 5 V amplitude, and the input voltage range of the 
MC_Card was +/- 2048 mV, 1 V should be fine. 

5. Enter a dead time that is long enough so that the second stimulus of the PPF protocol does not 
generate a second trigger event, that is, longer than 20 ms. To be on the safe side, enter 1000 ms, 
for example. 

 



MC_Rack Tutorial: MEA Application Examples 

58 

8.4 Extracting the Peak to Peak Amplitude 

For extracting the peak-to-peak amplitude, you will need an Analyzer. 

1. In the tree view pane of the virtual rack, select the Trigger Detector and click  on the toolbar 
to add an Analyzer in series with the Trigger Detector to the virtual rack. (If you would put 
both instruments in parallel, you would not be able to use the trigger stream generated by the 
Trigger Detector  for triggering the Analyzer, because virtual instruments can only use the 
output streams of other virtual instruments that are upstream in the virtual rack tree.) You can 
rename it so that you can identify it later in the virtual rack. 
 
The triggered Analyzer display with the region of interest (ROI) appears because the data  
was recorded as triggered sweeps. 

2. Rename the Analyzer to ROI 1 to distinguish it from the second analyzer that we will set up 
later. 

3. In the tree view pane of the virtual rack, select the Analyzer, and click the ROI tabbed page.  
The recording trigger Trigger 1 is already preselected, but you can also select the Trigger 4  
that is generated by the Trigger Detector 4. 
 

 

4. Click the Channels tab, and select the electrodes of interest (default is all). 

5. In the tree view pane of the virtual rack, select the Analyzer. Select the parameters of interest, 
Peak-Peak Ampl. in this case. 
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8.5 Defining the Region of Interest 

In triggered mode, the Analyzer extracts the parameters of interest from a distinct time 
window relative to the trigger event, the region of interest (ROI). The parameter of interest, 
the peak-to-peak amplitude in this case, is then extracted from the data trace in the region of 
interest. You can define the region of interest with the two vertical bars in the Analyzer display 
or by editing the T1 and T2 boxes on the ROI tabbed page of the Analyzer. 

1. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 

2. Double-click on any electrode channel with a large response in the Analyzer display to zoom  
into the data recorded from this electrode. Use the sliders to adjust the ranges so that you can 
clearly see the response. 

3. Position the bars T1 and T2 so that the field potential following the first stimulus is clearly  
inside the ROI. 

 

8.6 Defining the Second Region of Interest 

For defining the second region of interest in order to extract the amplitude of the response  
to the second stimulus, you will need to set up a second Analyzer. You need to configure  
the second Analyzer similar to the first one, except the distinct ROI. 

1. Click  on the toolbar to add a second Analyzer in serial to the first Analyzer to the virtual 
rack. (You will then be able to overlay the parameters extracted from both ROIs in the same 
Parameter Display. If you put the instruments in parallel, you would need two separate 
Parameter Displays for graphing the traces.) 

2. Rename the Analyzer to ROI 2 to distinguish it from the first analyzer. 

3. In the tree view pane of the virtual rack, select the Analyzer, and click the Channels tab.  
Select the same electrode channels that you have selected for the first Analyzer. 
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4. Click the Analyzer tab and select the parameters you like to extract,  
again Peak-to-peak Ampl. in this case. 
 

 

5. Click the ROI tabbed page. The recording trigger Trigger 1 is already preselected, but you  
can also select the Trigger 4 that is generated by the Trigger Detector 4. 

6. In the Analyzer window,  double-click on any electrode with a large response to zoom into the 
data recorded from this electrode. Use the sliders to adjust the ranges so that you can clearly see 
the response. 

7. Position the bars T1 and T2 so that the field potential following the second stimulus is clearly 
inside the region of interest, or enter the appropriate values (T1 and T2 of the first Analyzer  
+ 20 ms) directly into the T1 and T2 text boxes on the ROI page. 
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8.7 Plotting Amplitude versus Time 

Add a display to graph the Peak-to-Peak plot. As a parameter data stream is very different  
from raw data, MC_Rack features a specialized display type, the Parameter Display,  
which is optimized for parameter streams. 

 In the tree view pane of the virtual rack, select the second (bottom) Analyzer and click   
on the toolbar to add a Parameter Display in series with both Analyzers to the virtual rack.  
(It would not be possible to add the Parameter Display in parallel to the Analyzers, as the 
replayed data file does not contain any parameter streams as input streams for the display,  
and virtual instruments can only use the output streams of other virtual instruments that  
are upstream in the virtual rack tree.) 

Setting the window extent 

The total recording time of the example file is 90 s, as you can see on the File Info page  
of the Replayer. Adjust the ranges of the y-axis as well. 

1. Click the Ranges tab. 

2. Enter  90 s for the x-axis range, and 1000 μV for the y-axis. 
 

 

Selecting data streams 

Now, select the data that you like to be displayed. 

Note: You can only plot the data streams in the parameter plot that are generated by virtual 
instruments that are higher in the hierarchy of the rack tree and directly connected with the 
Parameter Display. In this rack configuration, both Analyzers (ROI 1 and ROI 2) are upstream 
the Parameter Display in the hierarchy (see screen shot below); therefore, both Parameter 1 
and Parameter 2 streams can be used by the display, that is, are visible on the Data page.  
If the two Analyzers were set up in two separate tree branches (in parallel), you would need  
two separate Parameter Displays, each downstream of each of the Analyzers. 
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1. In the tree view pane of the virtual rack, select the Display 1, and select the data streams that 
you want to plot. You can overlay the extracted amplitudes from both regions of interest,  
or you can set up two individual Parameter Displays for plotting the responses separately. 
 

 

2. Click Start  to plot the extracted parameters. The two different data streams are plotted  
in different colors (red from the first pulse, yellow from the second pulse). 
You can see a PPF on electrode 53, and a PPD on electrode 66, for example. 
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9 Spike Activity (Organotypic culture) 

9.1 Aim of Experiment 

 

Organotypic slices of the dendate gyrus (DG) and the entorhinal cortex (EC) taken from a 
PND 6 rat were co-cultured on MEAs for seven days. Both subregions showed an independent 
spontaneous spike activity. 

In an acute experiment, the slice (generally from adult animals) is used directly after preparation 
and discarded after the experiment. Slices from neonatal animals can also be kept in prolonged 
culture, over several weeks or even months, as so called organotypic cultures (OTC).  
Even though the synaptic organization is not exactly the same as in native tissue, the main 
characteristics and functions are preserved. OTCs have the advantage that they allow to observe 
the electrophysiological activity over a longer period of time on the same slice. Also, organotypic 
slices tend to thin out on the MEA, which is advantageous for optical imaging. OTC experiments 
are especially useful for longterm experiments, for example, for monitoring the development 
of the neuronal networks and its electrophysiological activity, the behavior of co-cultured slices 
from different regions and the regeneration of tissue (like in this experiment), or longterm  
drug effects. 

The demo data used in this part of the tutorial was kindly provided by Dr. Frank Hofmann, 
University of Heidelberg, Germany. 

Task 

Extract spikes and visualize the two-dimensional distribution of activity by an offline analysis; 
graph, print and save the results. 
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Note: In this chapter, you will set up an offline analysis rack (for the demo data file) step by step. 
You can set up a virtual rack for online recordings and analysis likewise, simply add the MC_Card 
as the data source to the rack instead of the Replayer. 

 Rack file: Neuro_OTC_Spikes_Demo.rck  

 Data file: Neuro_OTC_Spikes_Demo.mcd  

 Image file: OTC Spikes Image.jpg 

Please see also the MEA Application Notes for more information on the preparation techniques 
and experiments. 

You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Remove field potentials with a filter for a following spike extraction 

 Detect spikes 

 Analyze the spike rate 

 Visualize the spatial distribution of spike activity 

9.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file "Neuro_OTC_Spikes_Demo.rck".  
Click Open on the File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder from the installation volume into the MC_Rack 
program directory with the following path "c:\Program Files\Multi Channel Systems\MC_Rack\" 

2.  Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file Neuro_OTC_Spikes_Demo.mcd on the installation volume. 

9.3 Monitoring Raw Data 

You are ready to start to replay the data. We start with a simple Data Display for monitoring  
the raw data traces first. 

1. On the toolbar, click  to add a Data Display to the virtual rack and assign the Electrode Raw 
Data stream to it. Make sure that an 8x8 MEA Channel Map is loaded on the Layout page of the 
display. 

2. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. The recorded data traces are 
displayed in the (continuous) Data Display. 

3. Zoom in the ranges so that you can see the signals clearly. 
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Peak Detection 

With Peak Detection switched off, you do not see any spike bursts, the data looks atypical  
for spikes. 

Peak Detection is a very important display option. The massive amount of data points retrieved 
in the range of the time axis, 1000 ms in this case, that means 2500 data points at a sampling rate 
of 25 kHz, are reduced to a few pixels on the display, about 90 pixels. That means, about 28 data 
points are reduced to one. Without Peak Detection, only every 28th data point is actually 
plotted. The other 27 are skipped. As you can imagine, faster signals like spikes cannot be 
identified in the data at all. 

With Peak Detection, the highest and the lowest data point of the five pixels in this example are 
taken and connected to a straight vertical line. This results in a much more realistic representation 
of the data. On the other hand, this feature needs a higher computer performance for the 
internal data handling. You may want to deselect this option when you have a limited computer 
performance, indicated by a Performance Limit error message., or if you do not need the 
feature, because you are recording slow field potentials only. 

1. Select Peak Detection on the display toolbar for a more realistic data representation, and start 
the Replayer again. 

On the following screen shots, you can see that the spikes are only visible if Peak Detection has 
been selected. This option affects only the graphical representation of data, not the recorded 
or exported data. 

 

Fig. 3 Without Peak Detection 

Due to the graphical representation of the data, no fast signals like spikes are visible in the 
display. 

 

Fig. 4 With Peak Detection 

This is the same data as and display ranges as in the preceding screen shot. With Peak Detection, 
you now see bursting activity on the upper left half of the MEA.  
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9.4 Removing Field Potentials with a Filter 

1. Zoom in the signals a bit more. As you can see, spike signals are superimposed on  
local field potentials, which are built up by signals of cells firing simultaneously. 
 

 
 
If you would try to detect peaks by a threshold, you would miss most of the peaks. To circumvent 
this problem, you can use a digital filter that removes slow signals, that is, field potentials. In the 
current version of MC_Rack, a second order Butterworth filter is available. Please be aware that  
all filters deform signals. It has always to be made a compromise between good filtering and low 
signal deformation. (The other option would be to use the Slope mode of the Spike Sorter.  
In this mode, the Spike Sorter detects spikes on the basis of the waveform instead of a threshold, 
and thus is able to extract spike regardless of the baseline or underlying field potentials.) 

2. Click the Delete Instrument  button to remove the Data Display again to save computer 
performance. 

3. On the toolbar, click  to add a Filter to your rack. 

4. Click the Channels tab and select all channels. 
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5. Click the Filter tab. 
 

 

6. Select High Pass. 
You can choose between two filter types: Low Pass and High Pass. As the name suggests,  
a low pass filter passes the lower frequency components but attenuates the higher frequency 
components of signals. To remove slow components (with a low frequency) and to let pass high 
frequency signals, you need a high-pass filter. 

7. Type in 200 Hz as the Cutoff Frequency. The high-pass filter now cuts off frequencies below  
the specified 200 Hz. For spike activity, you usually use a Cutoff Frequency of 200 Hz or above, 
depending on the frequency of the noise and the slope / waveform of the spikes. The cutoff 
frequency of the filter must be compatible with the frequencies present in the signal of interest. 

8. Add a Data Display to your rack. Load the 8x8 MEA Channel Map. On the Data tabbed page, 
select the Electrode Raw Data and the Filtered Data streams. 

9. Click Start  to start the Replayer, and zoom the traces. 
The filtered data traces are displayed superimposed (magenta) on the unfiltered data (blue).  
You see that the field potentials have been more or less removed. You can now remove the 
display again from the rack to save computer performance. 
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9.5 Detecting Spikes 

The Spike Sorter detects spikes and features an online (or offline) spike sorting into up to three 
units. The spike cutouts form a new data stream that can be analyzed further (or recorded to the 
data file). 

There are two modes for detecting spikes with MC_Rack. One method uses a threshold, the other 
recognizes the amplitude and slope of the waveform of interest. Both methods regard either 
the rise or the fall of the input signal, depending on your settings. 

The threshold method is especially useful if the overall baseline is stable, and spikes appear 
approximately on the same height. If local field potentials are underlying the spikes, or if you 
have an unstable baseline, spikes will be missed, or noise signals may be detected as spikes with 
the threshold method. In this case, the Slope method is more appropriate. 

In this tutorial, we have used a digital high pass Filter to remove field potentials and to prepare 
the data for using the Threshold method. 

The Spike Sorter has a special display where you can either set the threshold, or sort spikes  
in an interactive kind of way. You can set the level for each channel separately (manually or 
automatically), or you can choose the same level for all channels. 

1. In the tree view pane of the virtual rack, select the Filter. On the toolbar, click  to add  
a Spike Sorter in series with the Filter to the virtual rack. (If you put the Spike Sorter  
in parallel to the Filter, it would not be possible to use the filtered data stream as an input  
stream for the Spike Sorter, because virtual instruments can only use the output streams of  
other virtual instruments that are upstream in the tree view as input streams.) The Spike Sorter 
display appears (in detection mode). 

2. Click the Channels tab and assign the Filtered Data stream to the Spike Sorter. 
 

 

3. Select the Peak Detection option of the display. Click the Start button and zoom the display 
until you can see the signals clearly. You see that the baseline is on a similar level for all channels 
and that the spikes are quite small (approximately 10 to 15 μV). 

4. Click the Detection tab. Make sure the Threshold method is selected. You can now set the 
detection threshold. Start with a value of 15 μV. 

5. Type in 15 in the text box. This value is now applied only to the selected channel. Under  
Apply to All, click Level to apply the new detection level to all channels. Spike cutouts appear  
in a different color in the display. The detection level is visible as a horizontal straight line.  
You see that the level could be set a bit higher though to catch more spikes. 
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6. Use the option Tune all levels to modify the level of all channels until the detection level seems 
to be optimized (approximately to -12 μV). You can also click and drag the detection level (black 
line) of each channel in the Spike Sorter display with your mouse. 

 

 

9.6 Analyzing the Spike Rate 

Hint: Instead of using the time-interval based Analyzer, you can also use the event-based  
Spike Analyzer for extracting the spike rate and the interspike-interval. Please see MC_Rack 
Features > Analyzing Data > Analyzing Data for details. 

1. On the toolbar, click  to add an Analyzer in series with the Spike Sorter to the virtual rack. 
(You cannot put the Analyzer in parallel to the Spike Sorter, because virtual instruments can 
only use the output streams of other virtual instruments that are upstream in the tree view as 
input streams.) 

2. In the tree view pane of the virtual rack, select the Analyzer. Click the Channels tab. 

3. Select all channels of the Spikes data stream. 

4. Click the Analyzer tab. 
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5. Select Rate. 

 

The data stream is continuous, therefore the Analyzer should process the data continuously, too. 
Internally, the Analyzer operates on distinct pieces of data, so called bins. You can enter the bin 
size. Standard is 1 s, which is ok if the overall spike activity is going to be monitored. 

 

9.7 Plotting the Spike Rate 

For plotting extracted parameters, we will need a Parameter Display, which features are 
optimized for graphing Parameter streams. 

1. In the tree view pane of the virtual rack, select the Analyzer and click  on the toolbar to add  
a Parameter Display in serial with the Analyzer to the virtual rack. (It would not be possible  
to add the Parameter Display in parallel to the Analyzer, as the replayed data file does not 
contain any parameter streams as input streams for the display, and virtual instruments can only 
use the output streams of other virtual instruments that are upstream in the virtual rack tree.) 

2. In the tree view pane of the virtual rack, select the Parameter Display and rename it  
to Spike Rate. Click the Layout tab to load the MEA Channel Map. 
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3. Click the Data tab and select the Parameter 1 Rate stream. 
 

 

4. Start the Replayer. 
The spike rate is plotted over time. You clearly see the two active tissues and the non-active  
area in the middle. The highest rate is about 60 Hz. 
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9.8 Visualizing the Spatial Distribution 

The Trace plot is good for monitoring the spike rate over the complete recording time.  
A False Color plot is the better choice for getting an idea of the spatial distribution and  
whether two regions fire simultaneously or independently. In a False Color plot, a specific  
color map is assigned to the parameter values, in this case, the spike rate. 

 Select the Parameter Display and click the Color tab. 
You see four color palettes. The selected Color Map defines the colors used for the plot.  
Each Color Map consists of 64 different colors arranged in a particular order. 

The minimum and maximum range of the y-axis (defined in the Range page) is assigned  
to the selected Color Map, that is, the most left color corresponds to the minimum y-value 
selected, and the most right color corresponds to the maximum y-value. The interval 
between min and max is straight-proportional to the colors in-between. The color of the actual 
value is picked from the Color Map accordingly. Parameter values outside the defined 
min/max range are plotted in Black. 

Example: If the range was set from min = 0 Hz to max = 64 Hz, each color of the map would 
correspond to 1 Hz steps. Spike rates lower than 1 Hz would then be plotted as the first (most left) 
color of the color map, spike rates between 1 Hz and 2 Hz would be plotted as the second color of 
the color map, and so on. A value above 64 Hz would be plotted in black.  

That means, for example, for the Gray Color Map, the lighter the color becomes,  
the higher is the spike rate. 

 

1. Click the Data tab and select the False Color plot type. 

2. Click the Ranges tab and set the y-axis to the maximum rate, that is, 100 Hz. 

3. Start the Replayer. 
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The first screen shot shows the right region firing, the second shows the left slice firing. You see 
now clearly that both brain slices fire independently. The Jet Color Map has been used here. 
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10 Retina: MicroERGs and Spikes 

10.1 Aim of Experiment 

 

The retina is a peripheral, easily accessible part of the central nervous system. Stimulation with 
light pulses results in a complex signaling by neurons within the layers of the retina. The retinal 
ganglion cells transmit retinal information to higher visual centers in the brain via their axons that 
form the optic nerve. Retinal function can be affected by acute injuries, intoxications, or retinal 
diseases, either inherited or acquired, resulting in visual impairment or even blindness. 

The electroretinogram (ERG) is an extracellular field potential generated by the cells in  
the retina. So-called microERGs can be recorded with the MEA-System from retina explants,  
for example, from rat or chicken. For the recording of light-evoked activity, a retinal segment  
with the pigment epithelium, is placed ganglion cell site down on an MEA. Local ERGs (microERGs) 
with the typical components and ganglion cell spikes can be recorded with appropriate filter 
settings with the MEA-System. The prominent components of the microERG can be 
pharmacologically identified. 

This in vitro retina sensor can be used for assessing effects of pharmacological compounds and 
putative therapeutics, drug side effects, and consequences of degeneration-related processes on 
retinal signalling. 

(Reference: A. Stett, U. Egert, E. Guenther, F. Hofmann, T. Meyer, W. Nisch, H. Haemmerle; 
Biological application of microelectrode arrays in drug discovery and basic research. Analytical  
and Bioanalytical Chemistry, 2003. 377, 486-495.) 
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Task 

Extract the spiking activity superimposed on microERG field potentials by an offline 
analysis; graph, print and save the results. 

Note: In this chapter, you will set up an offline analysis rack (for the demo data file) step by step. 
You can set up a virtual rack for online recordings and analysis likewise, simply add the MC_Card 
as the data source to the rack instead of the Replayer. 

10.1.1 Field potential electroretinogram 

The example data shows a typical microERG recording. The demo data  was kindly provided  
by the NMI Reutlingen, Germany. 

 Rack file: Retina_MicroERG_Demo.rck  

 Data file: Retina_ERG.mcd  

10.1.2 Spiking activity 

Spiking activity is visible in the ERG traces as well and can be easily extracted from the underlying 
field potential with the Spike Sorter in Slope mode.  

Alternatively, the field potentials can be removed by a digital 300 Hz High Pass filter,  
and spikes can be detected by setting a threshold. This sample rack demonstrates both methods, 
and the spike sorting feature. 

The raster plot highlights the regular spike pattern. 

The demo data used in this part of the tutorial was kindly provided by the NMI Reutlingen, 
Germany. 

 Rack file: Retina_Spikes_Demo.rck  

 Data file: Retina.mcd  

Please see also the MEA Application Notes for more information on the preparation techniques 
and experiments. 

You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Remove field potentials for extracting spike signals by digital filtering (Filter). 

 Detect spikes by defining the spike detection level (Spike Sorter, Threshold mode). 

 Detect spikes with an underlying field potential based on the waveform (Slope mode). 

 How to customize the rack: 

 Modify the display layout (all display types). 

10.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file Retina_Spikes_Demo.rck. Click Open on  
the File menu to open the rack file. 
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1. Copy the complete MC_Rack Tutorial folder from the installation volume into the MC_Rack 
program directory with the following path "c:\Program Files\Multi Channel Systems\MC_Rack\" 

2.  Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file Retina.mcd into the Replayer. 

 

10.3 Monitoring Field Potentials and Spikes 

With the MEA-System, you can record slow signals like field potentials and fast signals like spikes 
in parallel, depending on the amplifier settings. 

1. Click  on the toolbar to add a Data Display to the virtual rack. 

2. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 
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3. Zoom the axes to see the signals clearly. You see large sum potentials on all electrodes.  
Spikes are not detectable on all channels, but you can see spikes on electrode 25. 
 

 
  

4. Zoom into the data recorded from electrode 25 by double-clicking display 25. 
 

 
 
You see spike signals superimposed on the large field potential. It is impossible to detect all the 
spikes by defining a threshold. To circumvent this problem, you can use a filter that removes slow 
signals, that is, field potentials. In the current version of MC_Rack, a second order Butterworth 
filter is available. Please be aware that all filters deform signals. It is always a compromise 
between good filtering and low signal deformation. 
Another option would be to detect spikes by their waveform, that is, use the Slope mode of  
the Spike Sorter. We will look into this alternative later. 

5. Click the Delete Instrument  button to remove the Data Display again to save computer 
performance. 
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10.4 Removing Field Potentials with a Digital Filter 

1. On the toolbar, click  to add a Filter to the virtual rack. 

2. In the tree view pane of the virtual rack, select the Filter 1. Click the Channels tab and select  
the channel of interest, number 25 in this case. (Digital filtering is quite demanding regarding  
the computer performance and should be limited to the channels of interest.) 
 

 

3. Click the Filter tab. 

4. Select High Pass. 
You can choose between two filter types: Low Pass and High Pass. As the name suggests,  
a low pass filter passes the lower frequency components but attenuates the higher frequency 
components of signals. To remove slow components (with a low frequency) and to let pass high 
frequency signals, you need a high pass filter. 

5. Type in 300 Hz as the Cutoff Frequency. The high-pass filter now cuts off frequencies below  
the specified 300 Hz. For spike activity, you usually use a Cutoff Frequency of 200 Hz or above, 
depending on the frequency of the noise and the slope/waveform of the spikes. The cutoff 
frequency of the filter must be compatible with the frequencies present in the signal of interest. 
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6. Add a Data Display to your rack. Load the 8x8 MEA Channel Map. On the Data tabbed page, 
select the Electrode Raw Data and the Filtered Data streams. 

7. Click Start  to start the Replayer, and zoom the traces. The filtered data traces are displayed 
superimposed (blue) on the unfiltered data (red). You see that the field potentials have been 
removed. 
 

 
  

8. If you zoom into single spikes, you can also observe slight differences in the waveforms that are 
always obtained when filtering data. The negative component is slightly smaller after filtering,  
for example. This does not matter for analyzing timing and patterns, like extracting the spike rate, 
but you should keep this in mind when analyzing and comparing spike waveforms, for example, 
when you sort spikes. 
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10.5 Detecting Spikes (Threshold Mode) 

The Spike Sorter detects spikes, and features an online (or offline) spike sorting into up to  
three units. For example, you can use the Spike Sorter for sorting units from ON and OFF cells. 
The spike cutouts form a new data stream that can be analyzed further (or recorded to the data 
file). The unit information is saved in the data file and can be used for the analysis with external 
programs. The Spike Sorter has a special display where you can either set the spike detection 
level, or sort spikes in an interactive kind of way. 

There are two modes for detecting spikes with MC_Rack. One method uses a threshold,  
the other recognizes the amplitude and slope of a waveform. Both methods regard either  
the rise or the fall of a signal, depending on the settings. 

The Threshold method is especially useful if the overall baseline is stable, and spikes appear 
approximately on the same height. You can set the spike detection level for each channel 
separately (manually or automatically), or you can choose the same level for all channels.  
If local field potentials are underlying the spikes, or if you have an unstable baseline, spikes  
will be missed, or noise signals may be detected as spikes with the threshold method. In this  
case, the Slope method is more appropriate. 

In this tutorial, we have used a digital high pass Filter to remove field potentials and to prepare 
the data for using the threshold method. We will also demonstrate later how to extract spikes 
using the Slope method from unfiltered data. 

1. On the toolbar, click  to add a Spike Sorter in series with the Filter to the virtual rack.  
(If you put the Spike Sorter in parallel to the Filter, it would not be possible to use the filtered 
data stream as an input stream for the Spike Sorter, because virtual instruments can only use the 
output streams of other virtual instruments that are upstream in the tree view as input streams.) 
The Spike Sorter display appears (in detection mode). 

2. Select the option Peak Detection in the Spike Sorter display. 

3. Click the Channels tab and assign the Filtered Data stream to the Spike Sorter. 
As the Filtered Data stream includes only channel 25, only this channel will appear in the Spike 
Sorter window. All other window slots appear empty. You may want to customize the display 
layout at this point. 

4. Click the Start button and zoom the display until you can see the signals clearly. You see that  
the baseline is on a similar level for all channels and that the spikes are quite small (approximately 
10 to 20 μV). 

5. Click the Detection tab. Make sure the Threshold method is selected. You can now set the 
detection threshold. Start with a value of 15 μV, for example. 

6. Type in 15 in the text box. This value does apply now to the selected channel. Under Apply  
to All, click Level to apply this detection level to all channels. You can also use the Automatic 
feature to automatically assign an individual detection level to each channel, which is very 
convenient if you have multiple channels for extracting spikes. The standard deviation of each 
data trace is used to estimate its spike threshold. A time interval of 500 ms is used to calculate  
the standard deviation. You set the factor, by which the standard deviation is multiplied.  
The sign of the factor determines whether the spike detection level is positive or negative.  
You generally will use a negative factor. A value between -1 and -4 is appropriate for most 
applications. For example, enter a standard deviation of 2, and click Refresh to calculate the 
standard deviation and apply the result. Spikes appear in a different color on the display.  
The detection level of 8.5 determined for this channel by the Automatic feature is visible  
as a horizontal straight line. 
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7. The level may still be a bit too near the noise level. You can then fine tune the detection level  
by dragging the horizontal line of each channel in the Spike Sorter display with your mouse,  
or use a higher standard deviation. If you have multiple channels, you can use the option  
Tune all levels to modify the level of all channels at once. 
 

 
 

 

8. You can then switch to the spike overlay mode of the display by clicking the  button  

on the display toolbar, and switch back again to the other mode with the  button.  
Depending on the application, you could then use the spike sorting feature for discriminating 
signals from ON and OFF ganglion cells, for example. 
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10.6 Customizing Displays 

As it may not be useful to extract spikes from all channels, you can set up your custom layout  
for the Spike Sorter (this is true for all displays), to save space on the screen. You may be 
interested only in one or two channels. (Remember: You can save the raw data of all channels  
in the Recorder.) 

1. In the tree view pane of the virtual rack, select the Spike Sorter (or the display that you want  
to customize) and click the Layout tab. 
The default layout is loaded. In the Rows and Columns boxes, you can now modify the layout. 

2. Type or select the number of Rows, for example 1, and the number of Columns, for example 1. 
On the right, a linear layout with two channels appears. 

3. Assign the channel numbers to the empty slots, for example channel 25: Click to select the empty 
slot in the white layout pane, then pick 25 from the Channel list. The active slot is highlighted by 
a dotted line. The Spike Sorter Display is updated accordingly. 
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10.7 Detecting Spikes (Slope Mode) 

In Slope mode, spike detection is performed on the waveform rather than the spike level. 
Therefore, it is possible to extract spikes even if field potentials are underlying the spikes, as in 
this example. Therefore, you can extract the spikes from the unfiltered data with this method. 

1. In the tree view pane of the virtual rack, select the Spike Sorter, and click the Channels tab. 

2. Click the Electrode Raw Data stream, and then select channel 25. 
 

 

3. Click the Detection tab, and select the Slope method. 

4. You now have to play around with the amplitude (dV), and the minimum and maximum  
slope until you achieve satisfying results. For more information on the Slope mode, please see 
"MC_Rack Features", "Spike Sorter", "Detecting Spikes by Waveform". For example, you know 
that the minimum amplitude should be around 10 mV for this data, so you can try 10 for dV,  
and then play around a bit with the parameters. 
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11 Cardiac Signals 

11.1 Manual Measurement of the QT Interval 

If you need the averaged data as the basis for the analysis, you can measure the parameter  
with the crosshair tool. As the Na+ peak corresponds to the trigger event, the time point of  
the T wave is the relevant parameter. 

1. Right-click on the display and select the option Display Crosshair. 
A fine dotted line at the position of the mouse pointer. 

2. Move the mouse pointer on the T wave peak. You can now read the time point and amplitude  
of the peak on the scale. In this example, the QT interval is about 180 ms long. 
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11.2 Monitoring the QT Interval 

You can plot the extracted time point relative to T1 of  the ROI. For plotting extracted 
parameters, we will need a Parameter Display, which features are optimized for  
Parameter streams. 

 On the toolbar, click  to add a Parameter Display to your rack. You can rename it so that  
you will recognize it later. 

Setting the window extent 

As this demo data file has about 30 s total recording time, 30 s will be fine for the x-axis range.  
As the duration cannot be longer than the ROI, that is, 200 ms, you can enter 200 ms for the  
y-axis. 

1. In the tree view pane of the virtual rack, select the Parameter Display, and click the Ranges tab. 

2. Enter 30 s for the x-axis range, and adjust the y-axis to 200 ms. 
 

 

1. Click Start to generate the plots. 

The QT interval is stable (in the range of 170180 ms) in this control experiment with  
no drug application. 
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11.3 Customizing Displays 

As it may not be useful to extract parameters like the QT interval from all channels, you can set up 
your custom layout for the Analyzer and Parameter Display (this is true for all displays), to save 
space on the screen. You may be interested only in one or two channels. (Remember: You can save 
the raw data or extracted parameters of all channels in the Recorder.) 

1. In the tree view pane of the virtual rack, select the Analyzer (or the display that you want to 
customize) and click the Layout tab. 
The default layout is loaded. In the Rows and Columns boxes, you can now modify the layout. 

2. Type or select the number of Rows, for example 1, and the number of Columns, for example 1. 
On the right, a linear layout with two channels appears. 

3. Assign the channel numbers to the empty slots, for example channel 51: Click to select the empty 
slot in the white layout pane, then pick 51 from the Channel list. The active slot is highlighted by 
a dotted line. 
The Analyzer Display is updated accordingly. 
 

 

11.4 Automatic Extraction of the QT Interval 

You can use the Analyzer to automatically extract the QT interval, measured from the fast 
sodium peak to the maximum (or minimum, depending on the polarity of the signals) of the  
IKr current peak. Select channels of interest that show a very clear repolarization waveform. 

In triggered mode, the Analyzer extracts the parameters of interest from a distinct time 
window relative to the trigger event, the region of interest (ROI). As you need a different 
region of interest for extracting the time point of the IKr current peak than for the time point  
of the fast sodium peak, you need to set up a second Analyzer, based on the raw data stream. 
(You cannot use averaged data for an automated analysis in the current version of MC_Rack.) 

As the cardiomyocytes are electrically coupled to each other, it does generally not make much 
sense to analyze the QT interval on more than one electrode. As the parameters of interest  
are extracted from the region of interest relative to the trigger event, it is ideal to extract  
the QT interval from the channel that triggers the Analyzer (channel 51 in this example).  
(If you want to extract the interval from multiple channels, there will be different time shifts  
on the other channels, as the signal arrives at different time points at different electrodes.  
You can of course also define multiple triggers on different channels and set up an individual 
Analyzer for each electrode, but this will be on the cost of computer performance.) 

1. On the Edit menu, click Add Analyzer to add an Analyzer to your rack (in series with  
the Trigger Detector). You can rename the Analyzer to distinguish it from the other. 
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2. In the tree view pane of the virtual rack, select the Analyzer, and click the ROI tab.  
Select Start on Trigger 1, and enter values for T1 and T2 so that the ROI will approximately 
include the complete waveform, for example 0 and 200 ms. 
 

 

3. Click the Analyzer tab, and select the t-Max parameter for extracting the time point of  
the maximum inside the ROI. 
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4. Click the Channels tab. Deselect all electrodes by clearing the check box, and select the electrodes 
of interest, for example, electrode 51. Only the selected channel will appear in the Analyzer 
window. All other window slots appear empty. You may want to customize the display layout  
at this point. 
 

 
  

5. Start the Replayer to view the traces, and zoom in the axes so that you can clearly see  
the waveform. Adjust the region of interest by dragging the T1 and T2 cursors, if necessary,  
so that the IKr peak is safely inside the ROI. 
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11.5 Signal Propagation 

For measuring the signal propagation, you will extract the time point of the minimum (t-Min)  
or maximum (t-Max) of the fast sodium peak. 

1. Remove the Display 1 from the rack by clicking on the Display 1 in the tree view of the virtual 
rack and pressing the DEL key or by clicking Delete Instrument on the Edit menu. 

2. On the Edit menu, click Add Analyzer to add an Analyzer to your rack (again, in series with  
the Trigger Detector). 

3. In the tree view pane of the virtual rack, select the Analyzer, and click the Channels tab.  
Select all Electrode Raw Data channels. 
 

 

4. Click the Analyzer tab and select the parameter t-Max (or t-Min). 
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5. Click the ROI tab and select the option Start On Trigger 1. The Analyzer display opens.  
You can now define the region of interest (ROI) directly in the display or on the ROI page. 
 

 

6. Click the start button and zoom in the display so that you can see the waveforms clearly  
on all channels. 

7. Drag the ROI sliders such as that all signals from all electrodes are inside the ROI, or enter 
appropriate values into the T1 and T2 text boxes on the ROI page, for example T1 = 30 ms  
and T2 = 15 ms. T1 defines the left border, and T2 defines the right border of the ROI frame. 
 

 
 
On the Edit menu, click Add Parameter Display. The Parameter Display can be configured  
as an excitation map. 

8. In the tree view pane of the virtual rack, select the Parameter Display and click the Data tab. 
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9. Select the parameter t-Max. As plot type, select the False Color plot. 
 

 

10. Click the Color tab. Select any color map, for example, the Hot color map. The y-value ranges  
of the plot are now assigned to the colors of the false color map. You have to select a proper 
range so that the color assignment makes sense, that is, if the range is too wide, you will not  
see any differences in the color; if the range is too narrow, the colors will get into saturation,  
that is, black. 

11. Click the Ranges tab. Enter an appropriate range that starts with the lowest value for  
the parameter of choice t-Max and that stops with the highest t-Max value on the MEA.  
As you see an excitation at about 30 to 10 ms (in relation to the trigger event) on different 
channels, a range from 30 to 10 ms is appropriate. 
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12. On the Measurement menu, click Start to start the replaying of the data file. 

 

You can see the excitation spreading nicely from the lower right corner to the upper left corner. 
Low time values (= early signals) appear dark, the later a signal arrives at the electrode,  
the lighter gets the color, up to light yellow. 

11.6 Aim of Experiment 
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The MEA-System can be used for in vitro studies of the electrical properties of cardiac myocytes 
and, for example, effects of drug candidates on field potential waveforms and kinetics. 
Primary cardiac myocytes can be easily harvested from fertilized chicken eggs, or from neonatal 
rat or mouse. It is also possible to obtain murine and human embryonic stem cells derived 
from embryoid bodies. There is also one cardiomyocyte cell line from mouse that retains  
a differentiated cardiac myocyte phenotype: HL-1 from Dr. W. Claycomb. 

Plated cells form a syncytium and start beating spontaneously after a couple of days,  
or contract after electrical stimulation (pacing). The two-dimensional MEA layout is ideally 
suited for showing the waveform propagation and measuring the conduction velocity  
in a cardiomyocyte culture. 

Simultaneous recordings of action potentials (with intracellular electrodes) and field potentials 
(with extracellular electrodes) have shown that there is a correlation between the rise time of 
the cardiac action potential (AP) and field potential (FP) as well as between AP and FP 
duration. A correlation between the waveform components and the ion channel activities 
was shown by using ion channel blockers or by depleting the medium of the respective ions 
(Reference: "Determination of Electrical Properties of ES Cell-derived Cardiomyocytes Using 
MEAs”, Jürgen Hescheler et al., Journal of Electrocardiology, Vol. 37 Supplement 2004; 
"Estimation of Action Potential Changes from Field Potential Recordings in Multicellular Mouse 
Cardiac Myocyte Cultures", Marcel D. Halbach et al., Cell Physiol Biochem 2003;13:271 to 284). 

The high and short peak of the extracellular field potential can be correlated to the rapid 
component of the depolarizing sodium current. The following plateau follows the time course  
of the slow calcium current; and the following positive or negative peak correlates to the slow 
rectifying K+ current (IKr). The polarity of this peak depends on several parameters, for example, 
the proximity of the cell layer to the measuring electrode, and cannot be predicted, but this fact 
does generally not matter for this assay. 

The field potential duration corresponds to the action potential duration, which can be correlated 
to a QT interval in an electrocardiogram. It is measured from minimum of the Na+ peak to the 
maximum / minimum of the IKr current peak. 

The effects of tested drugs on QRS duration and amplitude, local activation time, T wave 
amplitude, time of maximal slope of T wave, QT interval duration, and ARI (activation 
refractory interval) can be analyzed with the MEA-System. 

Typical applications are: 

 Drug testing for effects on cardiac signal waveforms, for example QT prolongation 

 Analysis of changes in the signal propagation kinetics 

 Cocultures of stem cells and primary cells for basic research and for gaining insights into 
transplantation options and techniques 

 Characterizations of cells for cardiac properties, for example, of cardiomyocytes derived  
from stem cells 

You will see in this tutorial how a virtual rack is set up for those purposes, and how typical  
signal waveforms look like. Please note that the amplifier filter settings affect the waveforms  
of recorded signals. Please see additional documentation, for example, the MEA1060 Manual  
or MEA Application Notes for more information on this matter. 

The demo data shown here was recorded from chicken embryonic cardiomyocytes at a sampling 
rate of 10 kHz with a gain of 1200, and a bandwidth of 1 Hz to 3 kHz. The demo data 
Cardiomyocytes_QT.mcd was filtered with a digital 2 Hz high pass filter in MC_Rack. 
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You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Monitoring cardiac activity (Trigger Detector, Data Display). 

 Generate an excitation map (Analyzer, Parameter Display, False Color plot). 

 Averaging data for increasing the signal to noise ratio (Averager). 

 Automatically extract the QT interval (Analyzer). 

 Monitor the QT interval (Parameter Display). 

 How to customize the rack: 

 Modify the display layout (all display types). 

 More details: 

 Manually measure the QT interval, for example, from averaged data  
(Crosshair feature  of the Data Display). 

Excitation map 

The following rack and data file demonstrate the two-dimensional signal propagation. 

 Rack file: Cardiomyocytes_ExcitationMap_Demo.rck  

 Data file: Cardiomyocytes_60Ch.mcd 

QT Prolongation 

This rack and data file shows very prominent IKr peaks, and is therefore well suited  
for showing how to extract the QT interval from cardiac field potentials. 

 Rack file: Cardiomyocytes_QT-Analysis_Demo.rck  

 Data file: Cardiomyocytes_QT.mcd 

Please see also the MEA Application Notes for more information on the preparation  
techniques and experiments. 

11.7 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file "Cardiomyocytes_ExcitationMap_Demo.rck". 
Click Open on the File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder from the installation volume into the MC_Rack 
program directory with the following path "c:\Program Files\Multi Channel Systems\MC_Rack\" 

2.  Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 
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4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file Cardiomyocytes_60Ch.mcd into the Replayer. 

 

11.8 Monitoring Cardiac Activity 

1. On the Edit menu, click Add Trigger to add a Trigger Detector to your virtual rack. 

2. In the tree view pane of the virtual rack, select the Trigger Detector, and click the  
Trigger tab and select the channel that you want to use as a trigger, for example,  
channel 51. You can change the detection threshold level and the dead time on this page,  
but this is not necessary in the moment. 
 

 
  

3. In the tree view pane of the virtual rack, select the Trigger Detector and click  on the toolbar 
to add an oscilloscope-like Data Display in series with the Trigger Detector to the virtual rack. 
(If you would put both instruments in parallel, you would not be able to use the trigger stream 
generated by the Trigger Detector for triggering the display, because virtual instruments can 
only use the output streams of other virtual instruments that are upstream in the virtual rack 
tree.) Have a look at the display settings (Layout tabbed page) and make sure an 8x8 MEA 
Channel Map is loaded as the Channel Map, and Electrode Raw Data as the data input stream 
(see Data tabbed page). 
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4. In the tree view pane of the virtual rack, select the Display 1, click the Window tab,  
and click Start on Trigger. Trigger 1 is preselected, as it is the only available trigger  
stream in the rack. 
 

 
  

5. In the Data Display, select the option Peak Detection. 

6. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 
 
Sweeps triggered on the activity of channel 51 are plotted in the Data Display. You see cardiac 
activity on all channels. Zoom in the x-axis to see the different kinetics on different channels. 
 

 
 
You can see that the signal originates from the bottom right corner of the MEA and propagates 
to the upper left. Relatively to the trigger event (on channel 51), the signal appears at  
time = 30 ms at, for example, electrode 77, and it takes about 40 ms until it appears at  
time = 10 ms at electrode 12. 
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11.9 Averaging Cardiac Signals 

1. On the Edit menu, click Add Averager to add an Averager to the virtual rack (in series to the 
Trigger Detector). 

2. In the tree view pane of the virtual rack, select the Averager and click the Settings tab. 
In this page, a trigger is defined for the Averager, and the window extent of the cutout relative 
to the trigger event. 

3. Select the Trigger 1 that is generated by the Trigger Detector. (It is also possible to set up  
a new trigger for the Averager on the Trigger tabbed page.) Select the number of windows that 
should be summed up, in the range of 30. Select an appropriate Start Time and Window Extent 
(relative to the trigger event) for the about 200 ms long signals, for example 50 ms and 400 ms. 
 

 

4. On the Measurement menu, click Start to start the Replayer. Select Peak Detection  
in the Averager window and zoom in the axes. 
 
The data traces in each window are summed up until the target number of windows is reached. 
The summed up signal generates the data stream Averager 1, which can be saved with the 
Recorder. 

You can see that the signal-to-noise ratio and signal quality improves significantly with each 
window that is summed up. 
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12 Event-Based Analysis of Cardiac Activity 

12.1 Aim of Experiment 

 

This chapter describes how cardiac signals can be automatically detected with the Spike Sorter. 
The signal rate and the interspike interval (ISI) as parameters that characterize the beating 
rhythm can be monitored online during the experiment, and can be saved together with the  
raw data. The export features of the event-based parameter displays allow a direct export of  
the extracted parameters in universal ASCII format, or as a graphics file. 

The demo data used in this part of the tutorial was recorded from a cardiomyocyte cell line  
from mouse that retains a differentiated cardiac myocyte phenotype: HL-1 from Dr. W. Claycomb. 

You will see in this part of the tutorial how a virtual rack is set up for those purposes,  
and how typical signal waveforms look like. Please note that the amplifier filter settings  
affect the waveforms of recorded signals. Please see additional documentation, for example, 
the MEA1060 Manual or MEA Application Notes for more information on this matter. 

The demo data file Cardiomyocytes_HL1.mcd shown here was recorded from HL-1 cells  
at a sampling rate of 10 kHz with a gain of 1000, and a bandwidth of 1 Hz to 3 kHz. 

 Rack file: Cardiomyocytes_HL1_Demo.rck 

 Data file: Cardiomyocytes_HL1.mcd 
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You will learn in this chapter ... 

 

 How to define basic functions in your rack configuration: 

 Monitor cardiac activity (Trigger Detector, Data Display). 

 Signal detection (Spike Sorter). 

 Analyzing the signal rate and interspike interval (Spike Analyzer). 

 Monitoring the signal rate and interspike interval (Spike Analyzer Display). 

Please see also the MEA Application Note "HL-1 Cardiac Cell Line by Dr. W. Claycomb" for more 
information on the preparation techniques and experiments available for download on the web 
site of Multi Channel Systems MCS GmbH. 

12.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file "Cardiomyocytes_HL1_Demo.rck". Click Open 
on the File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder from the installation volume into the MC_Rack 
program directory with the following path "c:\Program Files\Multi Channel Systems\MC_Rack\" 

2.  Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file Cardiomyocytes_HL1.mcd into the Replayer. 
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12.3 Monitoring Cardiac Activity (HL1) 

1. On the Edit menu, click Add Trigger to add a Trigger Detector to your virtual rack. 

2. In the tree view pane of the virtual rack, select the Trigger Detector, and click the Trigger tab 
and select the channel that you want to use as a trigger, for example, channel 66. You can change 
the detection threshold level as well on this page (if the signal size is smaller or the noise level 
higher), but this is not necessary in the moment. Increase the dead time to the expected 
waveform length (here about 100 ms), to make sure that one signal is detected only once,  
as a single event. 
 

 
  

3. In the tree view pane of the virtual rack, select the Trigger Detector and click  on the toolbar 
to add an oscilloscope-like Data Display in series with the Trigger Detector to the virtual rack. 
(If you would put both instruments in parallel, you would not be able to use the trigger stream 
generated by the Trigger Detector for triggering the display, because virtual instruments can 
only use the output streams of other virtual instruments that are upstream in the virtual rack 
tree.) Have a look at the display settings (Layout tabbed page) and make sure an 8x8 MEA 
Channel Map is loaded as the Channel Map, and Electrode Raw Data as the data input  
stream (see Data tabbed page). 

4. In the tree view pane of the virtual rack, select the Display 1, click the Window tab, and click 
Start on Trigger. Trigger 1 is preselected, as it is the only available trigger stream in the rack. 
 

 
  

5. In the Data Display, select the option Peak Detection. 
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6. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 
 
Sweeps triggered on the activity of channel 66 are plotted in the Data Display. You see signals 
only on a few channels, because the conduction velocity of this cell type is very slow, and 
therefore, the time lag between the area, where the excitation starts to spread and other areas 
on the MEA is quite high. Therefore, you should increase the x-axis range to see the overall 
activity. 

Zoom in the x-axis to see the different kinetics on different channels. 
You now see there is cardiac activity on a majority of channels.  
 

 
 
The excitation starts at electrode 66 (which also triggers the display). Relatively to the trigger 
event (on channel 66), the signal appears at time = 50 ms at one of the neighboring electrodes  
# 55, and it takes about 460 ms until it appears at electrode 51. This documents a very different 
kinetic behavior as, for example, the chicken embryonic cardiomyocyte culture shown in chapter 
"Cardiac Signals", where the signal spread over the complete MEA in only 40 ms. 

A false-color excitation map as shown in the demo rack 
Cardiomyocytes_ExcitationMap_HL1.rck illustrates the signal spreading very well. A detailed 
explanation how to set up an excitation map is given under "Signal Propagation" in chapter 
"Cardiac Signals". You should use channel 66 for triggering, as the signal starts to spread from 
here, and because the signal quality is very good on this channel. 
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12.4 Signal Detection (HL1) 

The Spike Sorter is a general event detector for neuronal or cardiac applications that can either 
operate in two modes: One method uses a threshold, the other recognizes the amplitude and 
slope of a waveform. Both methods regard either the rise or the fall of a signal, depending on 
the settings. The Spike Sorter has a special display where you can adjust the spike detection level 
for each channel separately with the mouse. The Spike Sorter is called Spike Sorter because  
it also has a sorting functionality, which is used for spike analysis, but does not make much sense 
for cardiac applications. Therefore, it is not explained in this chapter. 

There are two modes for detecting spikes with MC_Rack. The Threshold method is especially 
useful if the overall baseline is stable, and signals appear approximately on the same height.  
You can set the detection level for each channel separately (manually or automatically), or you 
can choose the same level for all channels. If you have an unstable baseline, signals will be missed, 
or noise signals may be detected as signals with the threshold method. In this case, the Slope 
method is more appropriate. As the baseline is very stable in this experiment, we will use the 
(easier) Threshold mode. 

1. On the toolbar, click  to add a Spike Sorter to the virtual rack. 
The Spike Sorter display appears. 

2. Select the option Peak Detection in the Spike Sorter display. 

3. Click the Channels tab and assign the Electrode Raw Data stream to the Spike Sorter. 

4. Click the Start button and zoom the display until you can see the signals clearly. You see that  
the baseline is on a similar level for all channels and that the spikes are quite small (approximately 
10 to 20 μV). 
 
In contrast to the triggered display we used before, this display operates in a continuous 
(oscilloscope-like) mode: The displayed data is not synchronized to a trigger event. The refresh 
rate of the display is defined by the x-axis range selected from the drop-down list in the display 
header. For the slow signal rate of cardiac signals, a refresh rate of 1 or 2 s is fine. 

5. In the tree view pane of the virtual rack, select the Spike Sorter. Click the Detection tab.  
Make sure the Threshold method is selected. You can now set the detection threshold.  
Start with a value of 100 μV, for example. 

6. Type in 100 in the text box. This value does apply now to the selected channel.  
Under Apply to All, click Level to apply this detection level to all channels. 
You see that this level is fine for most, but not for all channels, as the signal amplitude differs. 

7. You could now adjust the threshold level for each channel separately. A more convenient 
alternative is to use the Automatic feature to automatically assign an individual detection level 
to each channel. The standard deviation of each data trace is used to estimate its signal threshold. 
A time interval of 500 ms is used to calculate the standard deviation. You set the factor, by which 
the standard deviation is multiplied. The sign of the factor determines whether the spike 
detection level is positive or negative. You generally will use a negative factor. A value between  
-10 and -20 is generally appropriate for larger cardiac signals. The smaller the signals, the lower 
you need to set the StdDev parameter. The higher you set the parameter, the more strict will be 
the signal detection. As there are also smaller signals here, you should start with a lower value. 
For example, enter a standard deviation of 10, and click Refresh to calculate the standard 
deviation and apply the result. 
 
The detected waveform appears in a different color on the display. The detection level 
determined for a particular channel by the Automatic feature is visible as a horizontal straight 
line. For example, the threshold was set to 50 on channel 34, and to 95 on channel 44 (with a 
higher noise level). 
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8. You can then fine tune the detection level by dragging the horizontal line of each channel in  
the Spike Sorter display with your mouse. This might be necessary, for example, on channel 43, 
where the signal to noise ratio is not so good. 
 
As a single signal crosses the threshold several times, it is necessary to increase the dead time,  
that is, the time following a detection event during which the Spike Sorter will not accept a  
new signal. 
 

 

9. In the tree view pane of the virtual rack, select the Spike Sorter and click the Settings tab. Enter  
an appropriate dead time, so that a single signal is not detected multiple times. As the waveform 
is about 100 ms long, 100 ms is an appropriate dead time. The Pre- and Post-Trigger times define 
the cutout length. As we are not interested in the cutouts, but only in the detection events, we 
can set the cutout times to zero. The generated Spike data stream will then contain only the time 
points of the detection events. (This is not important for monitoring, but only for recording to  
a data file.) 
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12.5 Analyzing the Signal Rate 

1. On the toolbar, click  to add a Spike Analyzer in series with the Spike Sorter to the  
virtual rack. (You cannot put the Spike Analyzer in parallel to the Spike Sorter, because  
virtual instruments can only use the output streams of other virtual instruments that are  
upstream in the tree view as input streams.) 

2. In the tree view pane of the virtual rack, select the Spike Analyzer. Click the Channels tab. 

3. Select all channels of the Spikes data stream. (You could deselect channels for saving computer 
performance or hard disk space in a real experiment situation.) 

4. Click the Analyzer tab. 

5. Select the parameter of interest, or both the Interspike Interval and the Rate. 

 

12.6 Monitoring the Signal Rate 

For plotting parameters that were extracted by the Spike Analyzer, we will need a Spike 
Analyzer Display, which features are optimized for graphing Parameter streams. The Spike 
Analyzer Display can plot the Interspike Interval and the Rate. If you want to monitor both 
parameters in parallel, simply set up two Spike Analyzer Displays in your virtual rack. 

1. In the tree view pane of the virtual rack, select the Spike Analyzer and click  on the  
toolbar to add a Spike Analyzer Display in series with the Spike Analyzer to the virtual rack. 
(It would not be possible to add the Spike Analyzer Display in parallel to the Spike Analyzer, 
as the replayed data file does not contain any parameter streams as input streams for the display, 
and virtual instruments can only use the output streams of other virtual instruments that are 
upstream in the virtual rack tree.) 
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2. In the tree view pane of the virtual rack, select the Spike Analyzer Display. Click the Layout tab 
to load the MEA Channel Map. 

3. Click the Data tab and select the Spike Parameter 1 stream. Select the parameter of interest, 
that is, either the Interspike Interval or the Rate. 
 

 

4. Start the Replayer. The signal rate is plotted over time. You need to adjust the axes to see  
the data points. 

5. Click the Ranges tab and adjust the ranges. For example, set the x-axis range to 25 s,  
and the y-axis range from 0 to 5 Hz. (You can see by subtracting the Start and Stop times  
on the File Info page of the Replayer that the total file length is 26 s.) 

 

The signal rate is very stable on most channels at about 0.5 Hz. You easily detect a short 
arrhythmia on some electrodes, for example, # 45. 
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13 Saving the Rack and Saving Data 

13.1 Saving a Rack 

Save the virtual rack configuration if you like to keep it for future use, for example for an offline 
analysis of identical data recorded in another experiment. 

1. On the File menu, click Save As. 

2. The Save As dialog box opens. 

3. Browse your folders and select a path. 

4. Enter a file name and confirm by clicking Save. 

The file extension for the rack files is .rck. 

13.2 Selecting Data Streams for Recording 

MC_Rack's philosophy is to strictly separate the actions of all virtual instruments in a rack. That 
means, that you could record to hard disk completely different data streams and channels than 
you monitor on the screen. This has the advantage that you can store exactly the channels you 
are interested in, but it also has the slight disadvantage that all virtual instruments have to be set 
up separately. Please be especially careful when configuring the Recorder, to avoid data loss. 

When you have finished setting up the rack, you can select the data streams and channels that 
you want to save to the data file specified in the Recorder. 

Selecting data streams and channels for recording 

The fate of each single channel is independent from other channels. You can pick exactly the 
channels you like to save from all generated data streams. For example, you can decide to save 
only one channel of raw data, but the peak-to-peak amplitude results of all, or of a specific 
selection of channels. 

1. Select the Recorder in the virtual rack tree view pane and then click the Channels tabbed page. 
On the white pane on the left of the Channels page, you see the data streams that are available 
with your rack configuration. When replaying data, you are generally more interested in the 
parameter data streams, but you can rerecord the raw data as well, in case that you want to save 
the raw data and the extracted parameters to the same data file. 
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2. Click the data stream that you are interested in, generally the parameter streams. 
The available electrode channels appear in a button array on the right side. Parameter stream 1  
is generated by the first analyzer in the rack (here: for extracting the peak-peak amplitude), 
parameter 2 is generated by the second analyzer (here: for extracting the slope). 
 

 

3. You can now either select all channels by clicking the check box next to the data stream name,  
or you can pick single channels by clicking the corresponding buttons. For more information, 
please see "Channel Selection" in the MC_Rack Features section. Only data from the selected 
channels will be saved to the hard disk. 

13.3 Creating a Data File 

If you want to write the parameters that you will extract in an offline analysis to the hard disk, 
you have to specify the file name and path in the Recorder. (It is not possible to change or 
overwrite existing data files in MC_Rack, for example, adding the spike rate to an existing data 
file, but you can record the raw data together with the spike rate stream to the same file.) 

Choosing the file name and path 

1. Click the Recorder tab. 

2. Browse your folders and select a path. 

3. Type a file name into the text box. 

4. Confirm by clicking Save. 

The data file is then generated automatically when you start MC_Rack in recording mode.  
The file extension for the data files is *.mcd. 
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File size limit 

When the maximum file size specified by the user has been reached, a new file is generated 
automatically. The file name is extended by four digits, counting up, for example  
LTP-Parameters0001.mcd, LTP-Parameters0002.mcd, and so on. 

If you rather prefer that the recording is completely stopped when a file has reached the 
maximum size, please select the option Auto Stop. 

For information on more options, please see "Generating Data Files" in the MC_Rack Features 
section. 

Selecting data streams and channels 

As has been said before, the fate of each single channel is independent from other channels. 
You can pick exactly the channels you like to save from all generated data streams. For example, 
you can decide to save only one channel of raw data, but the peak-to-peak amplitude results 
of all, or of a specific selection of channels. 

 Click the Channels tab. 

As long as the rack is still empty, you see an empty box. There are no channels available at this 
point, because you have not chosen a data source yet (MC_Card for online data acquisition or 
Replayer for replaying data files). Without a data source, there are no data streams available  
for recording. Remember later, when you have completed the rack, to assign the channels that 
you like to save to the data file to the Recorder. 

After you added a data source, you will see the electrode raw data streams provided by the data 
source (for example, electrode raw data, analog data, and digital data from the MC_Card, or the 
data streams included in the data file loaded into the Replayer). If the rack file contains virtual 
instruments that generate data streams such as Spikes from a Spike Sorter or Parameter streams 
from an Analyzer, these data streams will be available for recording as well. 
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13.4 Starting Data Acquisition and Recording 

Now that you have completed the virtual rack, you are ready to start the rack. 

 Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the data acquisition. Each virtual instrument in your rack starts to process the channels 
and data streams that were assigned to it. 

 Click first Record  and then Start  to write data to the hard disk. The data from the 
electrodes selected in the Recorder is saved to the file and location specified in the Recorder. 

 

 Click Stop  to stop the data acquisition. 

 

Warning: Only data of the channels and data streams that were selected in the Recorder are 
saved in your data file when you start a recording. Data is only saved to the hard disk when the 
red Record button is pressed in. Make always sure that you have selected all channels of interest, 
and that the Record button is active before starting an experiment to avoid data loss. 
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14 Glossary 

A 
aliasing: Frequencies (noise) that are above half the sampling rate (for example above 2.5 kHz  
at a 5 kHz sampling rate) will be transformed into lower frequencies. 

anti-aliasing: Using an analog Low Pass filter for removing high frequency noise, which would 
lead to aliasing if a sampling frequency lower than twice the bandwidth of the input signal is 
used. 

B 
Bandstop Resonator: In signal processing, a bandstop filter is a filter that passes most 
frequencies unaltered, but attenuates those in a specific range to very low levels. A bandstop 
filter with a high Q factor has a narrow stopband. 

Bessel Filter: A Bessel filter is a type of linear filter with a maximally flat group delay (maximally 
linear phase response). Analog Bessel filters are characterized by almost constant group delay 
across the entire passband, thus preserving the wave shape of filtered signals in the passband. 

bit: A bit is a binary digit, taking a value of either 0 or 1. The digital data stream of the MC_Card 
has 16 input and 16 output bits. A single bit can be used, for example, to trigger the recording 
(based on a TTL output of a stimulator) or an external device. Multiple bits can be used to set up 
more complex trigger patterns (where several requirements need to be met) or to encode a 
decimal number, for example, from an external measuring instrument. In a number, bits are 
always counted starting with 0, i. e. the 16 bits are numbered from 0 to 15. 

Bitmap (BMP): Standard Windows bitmap image format, file extension *.bmp 

Butterworth Filter: The Butterworth filter is one type of filter design. The frequency response  
of the Butterworth filter is maximally flat (has no ripples) in the passband, and rolls off towards 
zero in the stopband. For a second-order Butterworth filter, the response decreases at -12 dB per 
octave. 

C 
Chebyshev Filter: Chebyshev filters are analog or digital filters having a steeper roll-off than 
Butterworth filters. Chebyshev filters have the property that they minimize the error between  
the idealized filter characteristic and the actual over the range of the filter, but with ripples  
in the passband. Because of the passband ripple inherent in Chebyshev filters, filters which have  
a smoother response in the passband but a more irregular response in the stopband are preferred 
for some applications. 

continuous recording: Opposite of triggered recording. Recording is started once and the data 
is saved continuously to the hard disk until the recording is stopped. Note that a triggered data 
analysis or display (online or offline) is possible independent of the recording mode. 

D 
Device Independent Bitmap (DIB): Windows clipboard format, , file extension *.dib 

Digital Data: The Digital Data stream is the input data stream from the 16-bit digital input  
of the MC_Card. In a standard MEA- or ME-System, only three of the 16 digital input bits are 
available via BNC connectors. A digital in/out extension is available as an accessory for accessing  
all 16 input and output bits. The Digital Data stream can only have values of 0 and 1. It can be 
displayed with the Digital Data Display. 

Downsampling: The downsampling feature offers the possibility to generate raw and filtered 
data streams with different sampling frequencies to avoid huge amounts of resulting data when 
recording more than one data stream. 
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E 
Enhanced Meta File (EMF): Intermediate format for exchanging vector graphics data, file 
extension *.emf 

EPSP: Excitatory postsynaptic potential, an electrical change (depolarisation) in the membrane of 
a postsynaptic neuron caused by the binding of an excitatory neurotransmitter from a presynaptic 
cell to a postsynaptic receptor. 

F 
fEPSP: Field excitatory postsynaptic potential 

G 
Graphics Interchange Format (GIF): Indexed-color bitmap graphics, LZW-compressed format 
designed to minimize file size, binary transparency, file extension *.gif 

H 
High: Logical active state of a bit, also known as state 1 or On. For TTL pulses, a High state means 
a voltage level of usually 5 Volts. 

high pass filter: A filter that passes high frequency waveforms. For example, a 300 Hz high pass 
filter passes spikes, but no LFPs. 

I 
ICO: Bitmap format used for Windows icons (in programs and on desktop), file extension *.ico 

J 
Joint Photographic Experts Group (JPEG): Bitmap format, compressed by selectively discarding 
data, no transparency, file extension *.jpg 

L 
LFP: Local Field Potentials are sum field potentials of the activity within a volume of tissue.  
The amplitude reflects the number of active neurons that are contributing to the LFP.  
In comparison with single spiking activity, it is a lower frequency signal. To obtain only LFPs 
(without single spikes), a 300 Hz low pass filter can be used. 

Low: Logical inactive state of a bit, also known as state 0 or Off. For TTL pulses, a low state  
means 0 Volts. 

low pass filter: A filter that passes low frequency waveforms. For example, a 300 Hz low pass 
filter passes LFPs, but no spikes. 

lower cutoff frequency: Between the lower cutoff frequency and the upper cutoff frequency  
of a frequency band is the resonant frequency, at which the gain of the filter is at its maximum. 
Signal components with a lower frequency than the lower cutoff frequency of a band pass filter 
are attenuated. 

LTD: Long Term Depression 

LTP: Long Term Potentiation 

M 
MB (megabyte): One megabyte is equal to 1,048,576 bytes, or 1,024 kilobytes. 
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O 
OTC: Organotypic Culture: An MEA experiment where the slice is cultured on the MEA for weeks 
or months, in contrast to an acute slice experiment. 

P 
peak-peak: Interval from maximum to minimum signal 

PPD: Paired Pulse Depression 

PPF: Paired Pulse Facilitation 

R 
Real-time Feedback: The real-time feature allows the user to generate TTL signals in response to 
defined signal patterns detected by one or several electrodes. These TTL signals in turn can control 
a stimulus generator (STG) to deliver feedback stimulation to the biological sample within a time 
frame of one millisecond after the actual event.. 

ROI: Region of interest: In triggered operation mode, the Analyzer extracts parameters from  
a user defined region of interest. 

S 
Savitzky Golay Filter: IThe parameters of the Savitzky-Golay filter are the order (2 or 4) and the 
number of points which are included from the right and the left side of a data point for averaging 
the calculated data point (2, 4, 8, 16, 32, 48). This filter can be used to smooth a noisy signal. 
However, it is possible to accidental filter out fast signals, like spikes those in a specific range  
to very low levels. A bandstop filter with a high Q factor has a narrow stopband. 

spike: A field potential that is the extracellular representation of an action potential. The spike 
rate reflects the intensity of activity. In comparison with LFPs, it is a higher frequency signal.  
To obtain only spikes (without LFPs), a 300 Hz high-pass filter can be used. 

T 
triggered recording: A non-continuous recording of cutouts around a trigger event,  
for example, for recording evoked responses. The cutout size is selected in the Recorder.  
Note that the data in-between the cutouts is lost permanently. 

TTL: Transistor-Transistor Logic. Digital signal for communication between two devices.  
A voltage between 0 V and 0.8 V is considered as a logical state of 0 (LOW), and a voltage 
between 2 V and 5 V means a 1 (HIGH). 

U 
upper cutoff frequency: Between the lower cutoff frequency and the upper cutoff frequency  
of a frequency band is the resonant frequency, at which the gain of the filter is at its maximum. 
Signal components with a higher frequency than the upper cutoff frequency of a band pass filter 
are attenuated. 

W 
Windows Meta File (WMF): Intermediate exchange format for 16-bit Windows applications, 
limited vector graphics support, file extension *.wmf 






